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This document, the Epiphan web site, and the information contained therein, including but not limited to the text, 
videos and images as well as Epiphan System Inc.’s trademarks, trade names and logos are the property of Epiphan 
Systems Inc. and its affiliates and licensors, and are protected from unauthorized copying and dissemination by 
Canadian copyright law, United States copyright law, trademark law, international conventions and other intellectual 
property laws. 

Epiphan, Epiphan Video, Epiphan Systems, Epiphan Systems Inc., and Epiphan logos are trademarks or registered 
trademarks of Epiphan Systems Inc., in certain countries. All Epiphan product names and logos are trademarks or 
registered trademarks of Epiphan. All other company and product names and logos may be trademarks or registered 
trademarks of their respective owners in certain countries. For additional terms and conditions, refer to sections at 
the end of document. 

Copyright © 2018 Epiphan Systems Inc. All Rights Reserved. 

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE 
INFORMATION PACKET OR PRODUCT INSTALLATION SOFTWARE PACKAGE THAT SHIPPED WITH THE PRODUCT AND 
ARE INCORPORATED HEREIN BY REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSES OR LIMITED 
WARRANTY, CONTACT YOUR EPIPHAN REPRESENTATIVE FOR A COPY. 

PRODUCT DESCRIPTIONS AND SPECIFICATIONS REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO 
CHANGE WITHOUT NOTICE. EPIPHAN PERIODICALLY ADDS OR UPDATES THE INFORMATION AND DOCUMENTS ON 
ITS WEB SITE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION AND RECOMMENDATIONS ARE BELIEVED TO BE 
ACCURATE AT TIME OF WRITING BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. 
USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS. 

LIMITATION OF LIABILITY 

UNDER NO CIRCUMSTANCES SHALL EPIPHAN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, CONSEQUENTIAL, 
EXEMPLARY OR OTHER INDIRECT DAMAGES THAT RESULT FROM THE USE OF, OR THE INABILITY TO USE, THIS 
PRODUCT OR THE INFORMATION CONTAINED IN THIS DOCUMENT OR PROVIDED ON EPIPHAN’S WEB SITE, EVEN IF 
EPIPHAN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL EPIPHAN’S TOTAL 
LIABILITY TO YOU FOR ALL DAMAGES, LOSSES, AND CAUSES OF ACTION RESULTING FROM YOUR USE OF THIS 
PRODUCT, WHETHER IN CONTRACT, TORT (INCLUDING, BUT NOT LIMITED TO, NEGLIGENCE) OR OTHERWISE, EXCEED 
THE AMOUNTS YOU PAID TO EPIPHAN DURING THE MOST RECENT THREE-MONTH PERIOD IN CONNECTION WITH 
AMOUNTS WHICH YOU PAID FOR USING THIS PRODUCT. 

INFORMATION AND DOCUMENTS, INCLUDING PRODUCT SPECIFICATIONS, PROVIDED IN THIS DOCUMENT OR THE 
EPIPHAN WEB SITE ARE PROVIDED “AS IS”. SPECIFICALLY, BUT NOT WITHOUT LIMITATION, EPIPHAN DOES NOT 
WARRANT THAT: (i) THE INFORMATION IS CORRECT, ACCURATE, RELIABLE OR COMPLETE; (ii) THE FUNCTIONS 
CONTAINED ON THE EPIPHAN WEB SITE WILL BE UNINTERRUPTED OR ERROR-FREE; (iii) DEFECTS WILL BE 
CORRECTED, OR (iv) THIS WEB SITE OR THE SERVER(S) THAT MAKES IT AVAILABLE ARE FREE OF VIRUSES OR OTHER 
HARMFUL COMPONENTS. EPIPHAN SPECIFICALLY DISCLAIMS ALL REPRESENTATIONS, WARRANTIES, AND 
CONDITIONS, EITHER EXPRESS, IMPLIED, STATUTORY, BY USAGE OF TRADE OR OTHERWISE INCLUDING BUT NOT 
LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, TITLE, SATISFACTORY QUALITY 
OR FITNESS FOR A PARTICULAR PURPOSE. 



Thank you for choosing Epiphan! 
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Epiphan Videoにおいて、製品の機能と品質は最優先事項とされています。我々は ご要望を超える製品づ

くりに日々尽力しています。 

 
Product feedback 

 

Epiphan Videoでは皆様からのフィードバックをお待ちしておりますので、改善点など何かご要望などござい

ましたらご連絡ください。 info@epiphan.com ／ 株式会社アルゴ：argo@argocorp.com・06-6339-3366 

 
Specifications 

 

弊社HPのDVI2PCIeDuo製品ページには、DVI2PCIeDuoに関する最新の製品仕様や追加情報を記載しておりま

す。 

 
Warranty 

 

すべてのEpiphan Video製の製品は購入日より１年間、保証対応しております。 

 
Technical support 

 

Epiphan Videoでは製品に関してサポート担当を設けています。もしお使いのデバイスで何か問題が生じまし

たら詳細を下記までご連絡ください。 

弊社（株式会社アルゴ）よりご購入いただきましたお客様は弊社までご連絡ください。メーカーとの連絡は弊社

よりさせていただきます。株式会社アルゴ TEL：06-6339-3366／mail：argo@argocorpp.com 

⚫ Emailing support@epiphan.com 

⚫ Live chat via the link on our support site https://www.epiphan.com/support/ 

⚫ Phone toll free at 1-877-599-6581 or call +1-613-599-6581 

生じている問題に関して、可能な限り下記の情報を添えていただければ幸いです。 

⚫ 現象についての詳細情報 

⚫ ご使用の映像、音声の詳細（種類、解像度、リフレッシュレートなど） 

⚫ 製品のシリアル番号 

⚫ お使いのファームウェアバージョン 

⚫ LEDライトの状況 

 
Copyright © 2018 Epiphan Systems Inc. All Rights Reserved. 

mailto:info@epiphan.com
mailto:support@epiphan.com
https://www.epiphan.com/support
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DVI2PCIe Duoのファームウェアアップデート3.30.7.8は、安定性とパフォーマンスの強化を含むメンテナ

ンスリリースです。以前のバージョンをご利用の場合はアップデートしてください。 

重要事項: このファームウェアアップデート3.30.7.8は、DVI2PCIeDuo用のWindows32ビットドライバーバ

ージョンを含む最終アップデートです。 

SDIソースからのRGBカラーが反転されることを解決しました 

Ubuntu 18.04、14.15.0-22、およびWindows 10（64ビット）1709システムのSDIソースからRGBカラーを反

転しなくなりました。 

Web broadcasting demo 機能を削除しました 

Web broadcasting dem 機能はEpiphan Capture Toolから削除され、アイコンはツールバーに表示されなく

なりました。 

推奨ビデオコーデック（2019年3月） 

このユーザーガイドでは、クイックスタートで推奨されているffdshowビデオコーデックをK-Lite（Mega）ビ

デオコーデックパックのx264vfwコーデックに置き換えるための更新が行われました。 

ユーザーガイドで更新されたFCCコンプライアンスステートメント

（2020年4月） 

カナダのイノベーション、科学、経済開発に関するISED規則のICES-003のコンプライアンスステートメント

がこのユーザーガイドに追加されました。また、FCCの注意事項が追加されました。 
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はじめに 
 

 

ユーザーガイドのこの項では、DVI2PCIeDuoをすばやくご利用いただけるような内容を記載しています。 

付属品では製品に付属しているものを記載しています。DVI2PCIe Duoで概要を、システム要件でご利用のシ

ステムが要件を満たしているかをご確認ください。クイックスタートでは、キャプチャカードの装着と動作に

ついて、記載しています。 
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DVI2PCIe Duo 
DVI2PCIeDuo™は、PCIeデュアルリンクDVI-I / SDI（3G-SDI、HD-SDI、SD-SDI）ビデオキャプチャカー

ドです。シングルリンクおよびデュアルリンクのDVI-I、VGA、暗号化されていないHDMI、SDI映像ソースか

ら画像とビデオをキャプチャし、マザーボードのPCIeバスを介してワークステーションでデジタル化しま

す。 

ビデオキャプチャワークステーションは、結果として得られる非圧縮の画像、映像を保存/ストリーミングでき

ます。 Windowsでは、オーディオキャプチャとビデオキャプチャの両方がHDMI、SDIソースでサポートされて

います。オプションのAV Kitを使って、Sビデオ/コンポジット、アナログオーディオ、TRSオーディオ（バラン

ス）をキャプチャできます。 DVI2PCIe Duoは、毎秒60フレームでフルHDをキャプチャし、DVI-Iデュアルリン

クコネクタに接続すると、最大2048×2048の解像度で音声、HD映像ソースをキャプチャしてストリーミングし

ます。 

DVI2PCIe Duoは、デュアルリンクまたはシングルリンクのDVI、暗号化されていないHDMI、VGAソースか

らキャプチャすると同時に、3G-SDI、HD-SDI、SD-SDIソースからも映像と音声をキャプチャできます。 

付属のEpiphan Capture Toolを使用して、DVI2PCIeDuoは毎秒60フレームでフル1080pHDをキャプチャし、
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最大2560×1600の解像度に対応しています。すべての場合において、SDIビデオ信号はRGB 24bitカラーでキ

ャプチャされ、YUV 4：2：0クロマサブサンプリングされます。この新しい色空間に変換されることに注意

してください。 

DVI2PCIe Duoは、WindowsのDirectShowと完全に互換性があります。そのため、さまざまなサードパーティ

アプリケーションを使ってビデオのキャプチャ、録画、ストリーミングができます。 

DVI2PCIe Duoは、Epiphanのビデオ、オーディオ信号キャプチャ製品のラインナップのひとつです。 Epiphan

のすべてのビデオ信号キャプチャ製品の詳細については、Epiphan Video Webサイトの製品ページproducts を

ご参照ください。「アルゴHP：（映像信号入力）https://www.argocorp.com/grabber/eizou/dpgrab.html」

https://www.epiphan.com/products
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付属品 

DVI2PCIe Duoには以下のものが付属しています。 
 

1. DVI2PCIe Duo 本体(参照：本体各部名称) 

2. 3G 対応の SDIケーブル 

3. DVI-I ケーブル 

4. VGA - DVI ケーブル 

5. HDMI - DVI アダプタ 

6. 標準ブラケット 

7. ロープロファイルブラケット 

Table 1 Description of included cables (images for identification only, color and appearance may vary) 
 

Image Name Description 

 

 

 

SDI ケーブル 

 

DVI2PCIe DuoにSDI ソースを接続します。 

 

 

 

 

 

DVI-I ケーブル 

 

 

 

DVI2PCIe DuoにDVI ソースを接続します。 
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Image Name Description 

 

 

 

 

VGA - DVI ケーブル 

 

 
DVI2PCIe Duoに VGA (または、コンポーネ

ント：コンバータを使った場合) 信号を接続

します。 

 

 

 
 
 
HDMI - DVI アダプタ 

 

 

DVI2PCIe DuoにHDMI ソースを接続しま

す。 

 

 

 

ロープロファイルブラケッ

ト 

ロープロファイルのケースで使用します。

DVI2PCIe Duoにこのブラケットを取り付け

ます。 
 

 

 

標準ブラケット 
標準タイプのケースで使用します。

DVI2PCIe Duoにこのブラケットを取り付

けます。 
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本体各部名称 

DVI2PCIe Duoは、ビデオキャプチャワークステーションのマザーボード上の4x、8x、16x PCIeスロットに収

まるPCIe x4カードです。DVI-IとSDI（BNCタイプ）コネクタが各一つずつあります。 

パフォーマンスを高く保つためには、最低PCIe x4が必要です。ご利用のマザーボードのマニュアルをご覧い

ただき、使用するスロットがPCIe x4以上であるかご確認ください。 

 PCIeカードのパフォーマンスは、カードとスロットの長さ（x1、x4、x8、x16）とPCIeカードとマザーボ

ードスロットの世代によって決まります。 DVI2PCIe Duoカードは第2世代のカードで、第1世代のスロッ

トと下位互換性がありますが、その場合、第1世代の速度で動作します。 DVI2PCIe Duoカードは、第3世

代のスロットとも互換性がありますが、その場合、第2世代の速度で動作します。 

Table 2 Connectors and indicators 

 

Number Interface Description 

 

 

 

ブラケット 

コンピュータケースの背面にある開口部に入

る取付けブラケット。標準またはロータイプ

のブラケットをご使用ください。 

 

 

 

DVI-I 入力 
シングルリンクおよびデュアルリンクDVI、

HDMI、VGAソース用のデュアルリンクDVI-I

入力ポート。 

 

 

 

SDI 入力 
3G-SD、HD-SD、SD-SDIソース用のSDI入力

ポート。 

 
 

 

 

LED 

LEDライトは、DVI2PCIe Duoの現在のステー

タスを示します。光り方については、LED ラ

イトの詳細をご参照ください。 
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システム要件 

システム要件は、コンピュータが Epiphan ビデオグラバーと連携するために必要な技術的要素です。

DVI2PCIe Duoを使用するためのシステム要件は次のとおりです。 
 

 

映像ソース 

VESA規格準拠のVGA、DVI、HDMI、3G- 

SDI、HD-SDI、SD-SDIソース(HDCPで暗号化

されたソースはキャプチャできません) 

 
ビデオキャプチャワークステーション 

以下を備えたPC: 

⚫ 4x PCIe スロット (4x、8x、16x 

が対応しています) 

ビデオキャプチャワークステーションOS 
 

Windows 10 

RAM 推奨最低値: 4 GB 

有効なハードディスクスペース 16 GB (32bit OS)または 20 GB (64bit OS) 

エアフロー 
最小必要エアフロー：I140 LFM（0.7 m / s） 

 

温度／熱 

内部温度：最大80℃（APIを使用して現在

の温度を決定します） 
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キャプチャカードの装着 

ここでは、ビデオキャプチャワークステーションにキャプチャカードをインストールする流れを記載します。 

 

キャプチャカードの装着: 
 

1. インストールされているOSを介して適切なシャットダウンコマンドで、ビデオキャプチャワークステ

ーションの電源を切る 

2. ケースの背面にある電源装置の近くにある電源スイッチを使用して、電源を完全にオフにする（可能

な場合） 

3. ケースを開ける 

4. 静電気防止リストストラップ付属の説明書に従って、リストストラップをPC電源の金属ケーシングと手

首に取り付ける 

5. 空いているx4、x8、x16 PCIeスロットを見つけ、空の拡張スロットプレートを取り外す 
 

6. （必要に応じて）フルまたはロータイプのブラケットをDVI2PCIeDuoに取り付ける。オプションの

AVキットを使用している場合は、代わりにそのキットに付属のブラケットを使用してください。 

7. DVI2PCIe Duoの端を持ち、カードの端のコネクタをPCIeスロットに合わせる 

静電気によって、コンピュータ内部のコンポーネントが損傷する可能性があります。静電気によ

る損傷を防ぐため、ビデオキャプチャカードやコンピュータのコンポーネントに触れる前に、身

体から静電気を放電してください。最良の方法は、静電気防止リストバンドを使用することで

す。 
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8. カード取り付けブラケットをコンピュータシャーシの背面にあるスロットPCIe開口部に合うように配置

する 

9. 両隅に均等に圧力をかけ、カチッという音がするまでカードを押し下げる 
 

10. シャーシに応じて、ネジまたはレバーを使用してブラケットをシャーシに固定する 

11. リストストラップを外し、システムユニットを閉じる 

12. ビデオキャプチャワークステーションの電源を入れる。ドライバとEpiphan Capture Toolをインストー

ルする準備が整いました。 

カードをPCIeスロットに取り付けるときは、無理な力を加えないでください。カードのPCIe

コネクタが損傷する可能性があります。均等に圧力を加えてもカードが正しく装着されない場

合は、カードを取り外して慎重に取り付け直してください。 
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クイックスタート 

このクイックスタートをお読みいただくと、WindowsのキャプチャワークステーションでDVI2PCIe Duoを簡単に

起動し、ご利用いただけます。c 

ご利用前に: 

⚫ 必要なケーブル、コンポーネント、アダプタ（必要な場合）をすべて用意する。参照 付属品 

⚫ キャプチャワークステーションがシステム要件を満たしていることを確認する。 

⚫ カメラ、PC、タブレット、電話などの映像ソースを用意し、コンテンツがHDCPで保護されていないこ

とを確認する。Windowsの場合、HDMIまたはSDIソースでは同じケーブルを経由して映像と音声が入力

されることを確認する。 

⚫ ドライバをダウンロードするためのインターネットアクセス 

⚫ キャプチャワークステーションの管理者権限 

⚫ (オプションとして) キャプチャワークステーションにDVI2PCIe Duoが装着されていること。参照：キャプチ

ャカードの装着 

ドライバのインストール 

キャプチャカードを装着した後、ドライバをインストールすることをお勧めします。ただし、キャプチャワー

クステーションにキャプチャカードを装着する前に、ドライバをインストールすることもできます。 

1. 管理者権限を持つアカウントを使用してキャプチャワークステーションにログインする。ワークステー

ションがドメイン上にある場合は、ドメインのアカウントではなく、ワークステーションのローカル管

理者アカウントにログインしていることを確認してください。 

2. キャプチャワークステーションでWebブラウザを使用して、弊社HP ダウンロードサイト よりOSに合わ

せてドライバをダウンロードする。 

3. ダウンロードが完了したら、ダウンロード先フォルダを開く 

4. (オプションとして) 不要なウィンドウを全て閉じ、ワークステーションで実行されているプログラ

ムをシャットダウンする。セキュリティソフトウェアによっては、ドライバのインストールをブロッ

Windows 10 OSの場合、64bitまたは32bitのドライバを選択します。必要なドライバのバ

ージョンがわからない場合は、下記のマイクロソフトサポート記事をご参照ください。

https://support.microsoft.com/en-us/kb/827218 

https://www.argocorp.com/grabber/eizou/Epiphan/Epiphan_software.html#cap
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クする可能性があります。その場合、キャプチャワークステーションでドライバを更新できるように

する手順については、ご所属のシステム管理者に相談してください。 

5. すべてのドライバーファイルを展開し、ドライバとEpiphan Capture ToolをWindowsワークステーシ

ョンにインストールする 

a. .zipファイルを右クリックして、全て展開する 

b. 解凍したファイルフォルダからsetup.exeを右クリックし、[管理者として実行]を選択する 

c. インストールをクリックし、プロンプトに従ってドライバをインストールする。 Epiphan Capture 

Toolは、ドライバと同時にインストールされます。 

6. インストールが完了したら、キャプチャワークステーションを再起動する 

 

Windows用のビデオコーデックをインストールし、ビデオ圧縮

オプションを設定する  

ご利用のキャプチャワークステーションが Windows OSの場合、K-Lite (Mega) video codec packのインスト

ールをおすすめします。このコーデックパックはEpiphan Capture Toolで録画する際に設定できるビデオコ

ーデックオプションに追加します。非圧縮で録画すると、解像度が高い場合は特に大量のディスク領域が消

費されるため、おすすめしません。メーカーではテストをした結果、このコーデックパックのコーデック 

x264vfwが適しているとしています。 

Windowsキャプチャワークステーションに K-Lite (Mega) video codec pack をインストールする 

1. 管理者権限を持つアカウントでキャプチャワークステーションにログインし、Epiphan Capture 

Toolを起動する. 

2. From the Tools メニューの Options...を選択し、Display タブのDisplay format が RGB 24 bits per pixel 

(初期設定)に設定されているか確認する 

3. キャプチャワークステーションのWebブラウザでK-Lite (Mega version) video codec pack (32bit と

64bit version が含まれます)をダウンロードする 

⚫ K-Lite (Mega) video codec pack 

注）K-Lite Codec Pack MegaとK-Lite Codec Packは異なります。 

上記リンクページのServer１、Server２、Server３のいずれかをダウンロードし、インストールし

てください。同時に異なるものをインストールしないでください。 

インストーラーが管理者として実行されている場合でも、Windowsドメインからセキュ

リティアクセス許可を継承しているコンピュータのインストールが失敗する場合があり

ます。その場合は、ご所属のITチームにインストールのサポートを依頼してください。 

https://codecguide.com/download_k-lite_codec_pack_mega.htm
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4. ダウンロードした実行可能ファイルを見つけ、ファイルをダブルクリックし、プロンプトに従って、

ウィンドウのバージョンのK-Lite（メガ）コーデックパックをインストールする。Normalのインス

トールモードを使用し、初期設定のオプションで行います。コーデックパックのインストールが完了

したら、Finishをクリックする。 

5. Epiphan Capture Tool の Tools メニューの Options...を選択し、Recording タブをクリックする 

6. Recording タブの、Record as の項目を Video に設定し、Select Codec をクリックする 

7. 圧縮プログラムのドロップダウンから、 x264vfw - H.264/MPEG-4 AVC compression を選択し、OKを

クリックする 
 

 

 

8. 変更を保存するためにApplyをクリックする。すべての設定を終えたら OK をクリックします。 

最も一般的なインストールでは、ビデオ圧縮コーデックのデフォルト設定を使用

します。ビデオ圧縮パラメータを設定する必要はありません。 
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映像ソースを接続する 

ドライバとビデオコーデックがインストールされたので、キャプチャを開始する準備が整いました。キャプチ

ャカードを装着していない場合は、キャプチャカードの装着をご参照ください。 

標準のDVIケーブルを使用すると、DVIソースをDVI2PCIe DuoのDVI入力ポートに直接接続できます。 VGA

ソースを接続するには、VGA-DVIケーブルを使用します。 HDMIソースを接続するには、HDMI-DVIアダプ

ター（付属）を使用します。 

 

 

 

Epiphan Capture Toolを使ってキャプチャする 

必要に応じて、ツールの起動方法についてEpiphan Capture Tool をご参照ください。 
 

1. Epiphan Capture Toolを起動する; 映像ソースがすぐに検出されます。(もし No Signal というメッセ

ージが表示された場合、すべてが正しく接続されているかケーブルの抜き差しを行い確認してくだ

さい。) 

オプションとして、高品質のVGAスプリッター、DVIスプリッターを使用して、出力信号を

外部モニターとフレームグラバーでVGAまたはDVI信号を分割できます。 

サードパーティのキャプチャアプリケーションを使用して、DVI2PCIeDuoから映像をキャプチャ

することもできます。デバイスを選択するには、サードパーティのキャプチャアプリケーション

に付属のドキュメントを参照してください。 
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2. ビデオグラバーから音声もキャプチャしたい場合は、ツールバーの音声を有効にするボタンをクリッ

クする。音声が有効になっていることを示すスピーカーアイコンが変わります。 （ソースに音声がな

い場合、または別の音声入力方法を使用する場合はCapture » Audio Input Deviceを選択して音声ソー

スを選択します。） 

 

3. 赤い録画ボタンを押すと、録画が開始する。 Saveダイアログボックスが開き、ファイルを保存する

ファイル名とフォルダを指定します。 

 

 
 

4. キャプチャが完了したら、一時停止または停止ボタンを使用して、録画を一時停止または停止する 
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5. OSのファイルブラウザを使って、保存したファイルを確認する 
 

 

つづいて 

ここまで基本的な録画までの流れをお伝えしましたので、以下の機能もお試しください。 

⚫ デバイス設定 

⚫ DirectShow video調整 

⚫ Epiphan Capture Tool 

これらの記載しているページは目次をご参照ください。 

デバイスに古い、もしくは正しくないEDIDがロードされていると、HDMIオーディオキャプチ

ャが失敗する場合があります。EDIDのアップデートをご参照ください。 
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LEDライトの詳細 

DVI2PCIe Duoには、DVI-Iコネクタの近くに小さなLEDライトがあります。主にトラブルシューティングに

使用されるこのLEDは、必要に応じて、コンピュータのケースを開けてご確認ください。 

 
 

LED color Description 

 

赤点滅 
動作中は、DVI2PCIeDuoが画像をキャプチャするたびにLEDが点滅しま

す。 

 

緑と青Green and blue 

コンピュータの起動中、LEDは数秒間青点灯し、その後約20秒間緑点灯に変わ

ります。その後、再び青点灯に変わり、画像キャプチャの準備ができたことを

示します。 

 

青点滅 
信号テスト操作中およびシステムがキャプチャパラメータを調整している

ときに、青色のLEDが点滅します。 
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トラブルシュート 

DVI2PCIe Duoで問題があった場合は、以下の内容をご参照の上、トラブルシュートをお試しください。 
 

Capture device not found 

Epiphan Capture Tool がビデオグラバーを見つけられない場合、このアプリケーション画面上に“Capture device not 

found”というメッセージが表示されます。 

トラブルシューティング: 

⚫ ビデオグラバーが正しく装着されているか確認してください。正しく接続されているとデバイスの

LEDランプが点灯します。 

⚫ ビデオグラバーの装着をもう一度やり直してみてください。ビデオグラバーのドライバをOSがロード

できていなかった場合、ロードできます。 

⚫ LEDライトの色と光り方を確認し、LEDライトの詳細に記載されている内容と比較します。 

⚫ On Windowsであれば、デバイスマネージャーでデバイスリストにビデオグラバーが表示されてい

るか確認します。  

⚫ 上記を試しても問題が解決しない場合は、すべてのアプリケーションを閉じ、キャプチャワークス

テーションを再起動します。 

スプリッターを使用する場合は、必ず高品質のスプリッターを使用してください。 VGAスプリ

ッターの場合は、パッシブまたはYアダプタースプリッターではなくアクティブVGAスプリッ

ターを使用してください。 
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No signal detected 

Epiphan Capture Tool がビデオグラバーを見つけてはいるものの、接続している映像ソースが表示されて

いない場合、アプリケーション画面上に“No signal detected”というメッセージが表示されます。 

トラブルシューティング: 

⚫ アプリケーションで見つけているビデオグラバーが正しいか確認します。アプリケーション画面の枠

（左上）部分に表示されているシリアル番号（上の例では300292）と、デバイス背面のステッカーに

記載されているシリアル番号を見比べ確認します。もしそれらの番号が異なれば Capture » Select 

device... (Windows) から別のビデオグラバーを選択します。 

⚫ 映像ソースの電源が入っているか、ビデオグラバーに接続されているビデオケーブルへ映像出力が

されているかを確認します。（映像ソースのハードウェア・ソフトウェアの設定である可能性もあ

ります） 

⚫ 映像ソースとビデオグラバーの接続をやり直してみる。（ケーブルの抜き差しをしてみる） 

⚫ LEDライトの色と光り方を確認し、LEDライトの詳細に記載されている内容と比較します。 

 

設定変更を適用するボタンが表示されない 

 Windowsで、Epiphan Capture Toolで設定を変更する際に、適用ボタンが表示されない場合はアプリケーシ

ョンが管理者権限で開かれていません。一度アプリケーションを閉じ、管理者権限で再度開いてください。 

Windowsの電源を入れても、接続しているビデオグラバーを認識

しない 

高速スタートアップを無効にしてみる。高速スタートアップの無効は、電源オプション ＞ 電源の追加設定 ＞ 

電源ボタンの動作の選択 から行えます。 
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Windowsキャプチャワークステーションの問題が解決しない場合... 

電源設定の変更を試してみる。電源オプション ＞ 電源の追加設定 ＞ プラン設定の変更から電源オプション

が高パフォーマンスになっているか確認します。ノートPCの場合はACアダプタが接続されていることも確認

します。 

プラン設定の変更 ＞ 詳細な電源設定の変更から、これらの電源設定を変更します。 

⚫ USB 設定: USBのセテクティブサスペンドの設定を無効にする 

⚫ PCI Express: リンク状態の電源管理をオフにする 

 

Sync on Green (SoG) 信号をキャプチャできない 

Windowsでは、コンピュータを起動する前にソース入力が接続されている場合、DVI2PCIe DuoはSync on 

Green（SoG）信号をキャプチャしない場合があります。ワークステーションで高速スタートアップ設定を

無効にしてみてください。 電源オプション ＞ 電源の追加設定 ＞ 電源ボタンの動作の選択する ＞ 現在利用

可能ではない設定を変更します からで高速スタートアップを有効にする を無効にできます。 
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デバイス設定 
 

 

Epiphan Capture Toolで画像の調整やVGA modeの選択（アナログ信号のために）、ビデオグラバーが

DirectShow対応のアプリケーションでどのように動作するかなどを設定できます。 

設定画面に表示されるメニューは、ビデオグラバーに接続しているソースの種類によって異なります。メニ

ュー項目の一部はVGAソースにのみ適用できるため、VGAソースが接続されている場合にのみ表示されま

す。 

設定画面へのアクセスは以下の2通りの方法があります。 

1. Epiphan Capture Toolの  Capture » Configure Device... を選択するか、 

2. Windows コントロールパネルを開く 

a. Epiphan Frame Grabbers をクリックする。Epiphan Frame Grabber Configuration 画面が現れる 

b. 設定したいデバイスを選択する 

c. Edit Configurationをクリックする。 設定画面が開く。 
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DirectShow video 調整 

Epiphan Capture Tool にある Capture » Configure Device » DirectShow タブでは、デバイスがDirectShow 対応の

アプリケーションとどのようにやり取りをするかを設定できます。解像度、画像を反転するかどうかなど、さまざ

まなオプションが利用できます。各オプションについては、以下の表をご参照ください。 

コントロールパネルのEpiphan Frame Grabbersから、設定したいビデオグラバーを選択し、Edit Configureま

たは  Default Configurationをクリックして、設定画面にアクセスすることもできます。 

ここで行った設定はデバイスドライバーに保存され、再度変更するまで使用されます。適用後はEpiphan 

Capture Toolを閉じても設定は保持されます。サードパーティのDirectShow対応アプリケーションであって

も、設定が反映されていないように見える場合があることに注意してください。変更を確認できない場合は、

サードパーティアプリケーションの詳細設定を確認してください。 

 

Item Description 

 

 
Fix resolution 

この設定は、ビデオグラバーがDirectShow 対応アプリケーションへ受け

渡す解像度を指定します。チェックを入れると、ドロップダウンに解像

度を選択するためのリストが表示されます。 

映像ソースよりも小さい、または大きい解像度を選択すると、ドライバが

画像をスケーリングします。（Scale image to match stream resolutionにチ

ェックを入れない限り、選択した解像度に一致するようにクロップします。） 
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Item Description 

 

Default image 

ビデオグラバーが何も映像信号を受け取っていないときに表示する画像

を選択します。非圧縮のBMP画像は、ビデオキャプチャワークステーシ

ョンに保存する必要があります。 

 

 

 

 

 

Scale image to match stream 

resolution 

固定解像度（fixed resolution）を使用しており、画像スケーリングをし

ないことを選択している場合、DirectShow対応アプリケーションでキャ

プチャすると、キャプチャされた画像は指定された解像度にクロップさ

れて表示されます。通常、クロップ画像の左上隅を起点にして行われま

すが、はじめに表示される画像を確認してください。 

通常、DirectShowで固定解像度を使用することを選択する場合は、ドラ

イバで画像をスケーリングする必要があります。スライドバーで必要な

スケーリングのタイプを決めます。スケーリング動作は、キャプチャコ

ンピューターの品質とCPUサイクルの間でトレードオフです。低品質

（スライドバーの左側）は高速でCPUサイクルが少なくて済みますが、

高品質（スライドバーの右側）は低速でCPU時間が長くなります。さま

ざまな値を試して、ご利用のケースに適した値を見つけてください。 

 

Flip image vertically 
DirectShowへデータを送信するときにキャプチャした画像を垂直方向に

反転します。 

 

 

 

Limit frame rate to 

DirectShowに送信するデータのフレームレートを制限（または固定）し

ます。 

たとえば、WebExなどのDirectShow対応アプリケーションを使用してい

て、比較的動きが少ないもの（PowerPointプレゼンテーションなど）を

共有している場合は、フレームレートを5 fpsに制限できます。見ている

だけであれば、このくらいの値で十分ですし、同じ画像データを何度も

繰り返し送ることを避けられます。 
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映像の見え方の調整 

Adjustmentsタブでは、データの微調整やキャプチャ元のカラーモードを管理するようにデバイスを

設定できます。 VGA信号を接続している場合は、VGA固有の調整パラメータを設定するためのオプ

ションも利用できます。 

この画面にアクセスするには、Capture » Configure Device » Adjustmentsを選択するか、コントロール

パネルのEpiphan Frame Grabbersから、設定するビデオグラバーを選択し、Edit Configuration まは

た Default Configurationをクリックします。 

メインの調整画面は、接続されているソースに応じて以下のようになります。（左側にHDMI/DVIソ

ース、右側にVGAソースの場合） 

 

Item Description 

 

 

Horizontal shift 

キャプチャされた画像の位置をオフセットするように水平位置を微調

整します。たとえば、キャプチャした画像が少し右に（水平に）移動

すると、horizontal shift の設定を少し調整するだけで修正できます。

Horizontal shift に入力した値を大きくすると、画像が右に移動し、小

さくすると、画像が左に移動します。 

 

Vertical shift 
キャプチャされた画像の位置をオフセットするように垂直位置を微調整

します。たとえば、わずかに下に（垂直に）移動されたキャプチャ画像

は、vertical shift 設定をわずかに調整することで修正できます。 

Vertical Shift に入力された値を増やすと画像が上に移動し、減らすと

画像が下に移動します。 

 

Set offset/gain 

(brightness/contrast) 

VGA sources only 

オフセットとゲインの設定は、それぞれ画像の明るさとコントラストを

制御します。 

オフセットコントロールを大きくすると、画像が暗くなります。ゲイン

コントロールを大きくすると、画像のコントラストが高くなります。 

 

Sampling phase 

VGA sources only 

この設定は、画像の垂直同期プロパティを調整します。画像の横軸に繰

り返し歪みやぼやけがある場合にお試しください。より鮮明な画像が表

示されるまで、設定を少しずつ調整します。 

PLL adjustment 

VGA sources only 

 

こちらの設定は画像を水平方向に縮めるか、伸ばすかを調整します。 
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Prefer wide VGA mode 

VGA sources only 

このチェックボックスを使用すると、ワイドアスペクト比の VGA モード

をビデオキャプチャアプリケーション画面に表示できます。 ドライバ

は、ビデオソースがワイドビデオモード信号を送信しているかどうかを

判断できない場合があります。ビデオソースがワイドビデオモードを使

用して、ドライバがワイドビデオモードを選択していることを確認する

場合は、このオプションを選択できます。 

 

YCrCb capture 

通常、DVI2PCIe Duoは入力形式を自動検出しますが、入力形式が検出さ

れない問題があった場合、このチェックボックスにチェックを入れ、

YCrCb エンコーディングでアナログコンポーネントビデオをキャプチャ

できます。 

 

Swap interlaced fields 

ソースによっては、ビデオグラバーはインターレースラインを配置する順

序を正しく決定できません。このチェックボックスを使用してライン順を

反転できます。 

 

VGA modesの設定 

VGA Modesタブではアナログビデオキャプチャに使われるVGA modeを設定できます。 

この画面にアクセスするには、Capture » Configure Device » VGA Modes を選択するか、コントロールパネ

ルの Epiphan Frame Grabbers から、設定するビデオグラバーを選択し、Edit Configuration または Default 

Configuration をクリックします。 

ビデオグラバーは、初期設定で多くの一般的なVGA modeをサポートしています。ただし、カスタムVGAソー

ス（つまり、カスタムの解像度やタイミング）からキャプチャする場合は、ここに追加できます。ソースのキ

ャプチャパラメータを調整するときに、ビデオグラバーが使用しないようにするVGA modeのチェックを外す
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こともできます。 

custom VGA modeを追加する: 

1. Epiphan Capture Toolを起動する 

2. Capture » Configure Deviceを選択し、設定画面を開く 

3. VGA Modes タブを選択する 

4. +ボタンをクリックし、custom VGA modeを追加する。設定画面が開きます。
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5. Horizontal pixels と Vertical lines の項目に値を入れ、カスタムフレームサイズを指定する 

6. ソースのRefresh rate を指定し、インターレースかどうか、ブランキングを減らす必要があるかをチェッ

クする 

7. ソースが特殊なタイミングを使用している場合は、Standard VESA timings のチェックを外す。一連

の技術的なタイミングの詳細が表示され、それぞれにカスタムタイミング値を入力します。 （ソース

のタイミング値がわからない場合は、標準の VESA タイミングを使用し、Configure Device の 

Adjustmentsタブを使用して画像を微調整します。） 
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Advanced調整 

Advancedタブでは、デバイスの自動調整、検出メカニズムを設定できます。 

この画面にアクセスするには、Capture » Configure Device » Advanced  を選択するか、コントロールパネルの

Epiphan Frame Grabberから設定するビデオグラバーを選択し、 Edit Configuration ま た は Default 

Configurationをクリックします。 

advanced調整画面は以下です。 
 

 

Item Description 

 

Auto-adjustment interval 

ビデオグラバーが自動調整の際に使うインターバルを秒単位で指定しま

す。通常この値を変更する必要はありませんが、キャプチャ中、ソース

を頻繁に変更する場合はインターバルを少なくしておくことをおすすめ

します。 

Sync level adjustment 

HSync and VSync 

水平、垂直シンクレベルを調整します。（SDIソースではこの機能は適

用されません） 
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DVI2PCIe Duoは入力形式を自動検出します。ただし、入力形式が検出されなければ、

AdjustmentsタブからYCrCbエンコーディングを使って、手動でアナログコンポーネントビデ

オをキャプチャできるように選択できます。またビデオグラバーがインターレースラインを正

しく判断できていない場合は、Adjustmentsタブからインターレースラインを反転させること

もできます 
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Epiphan Capture Tool 
 

 

Epiphan Capture ToolはWindowsで利用できる無料のソフトウェアアプリケーションです。ソースからの画像

をキャプチャ、録画することに使用でき、サードパーティの DirectShow対応プリケーションで使用するように

ビデオグラバーを設定することもできます。 

Epiphan Capture ToolはEpiphanが提供するドライバを使用するすべてのEpiphanのビデオキャプチャデバイス

でご利用いただけます。（ DVI2USB 3.0, SDI2USB 3.0, DVI2PCIe Duo ) そのため、ソフトウェアの一部の機能は 

DVI2PCIe Duoに適用されていない内容も含まれます。このガイドでは、関連する機能の概要と、各機能の使用方法

について説明します。 

Epiphan Capture Tool 
アプリケーションを始めるため、Windowsのスタートメニューから、Epiphan Capture Toolを選択するか、デスク

トップアイコンをダブルクリックします。 

アプリケーションが起動すると、PCに接続されているDVI2PCIe Duoを探します。 

ビデオグラバーが接続され動作していれば、キャプチャアプリケーションはそのビデオグラバーを見つ

け、アプリケーション画面上でキャプチャしている画像を表示します。 

アプリケーションが起動すると、以下のようなメッセージが表示される場合があります。 

⚫ Capture device not found はアプリケーションがビデオグラバーとの接続を試みている際に表示されます。 

⚫ Detecting Video Mode はアプリケーションとビデオグラバーが接続し、ビデオグラバーのビデオ形式

https://www.epiphan.com/products/dvi2usb-3-0/
https://www.epiphan.com/products/sdi2usb-3-0/
https://www.epiphan.com/products/dvi2pcie-duo/
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を決定する際に表示されます。 

⚫ Tuning Capture Parametersはアプリケーションが同期、キャプチャ設定の調整、画像調整の際に表

示されます。 

⚫ No Signal Detectedはアクティブな映像ソースとビデオグラバーが接続していない際に、表示

されます。 

映像ソースと接続しているにもかかわらず、ビデオグラバーがキャプチャしない場合はトラブルシュート 

をご参照ください。 

Epiphan Capture Toolには以下のメニュー項目があります。 
 

 
 

File メニュー、 Edit メニュー (Windows)、 View メニュー、 Capture メニュー、 Help メニュー、 Toolbar、

ステータスバーについてはそれぞれの項目をご参照ください。 

現在選択しているビデオ

グラバー 現在のキャプチャ

情報 

ツールバー 

メニュー 

キャプチャされた

ソース 

ステータスバー 
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メニュー 

Epiphan Capture Toolのメニューをそれぞれ紹介します。 

DVI2PCIe Duoに接続しているソースによって、表示されるメニューは異なります。ここではDVI-I入力、

SDI入力どちらのソースにも適用できる、すべてのメニュー項目について紹介します。  

 

File メニュー  
 

The File menu has these options: 
 

Menu item Shortcut Description 

 

Save 

 

Ctrl+S 
現在の画像のスナップショットをビデオキャプチャワークステーショ

ンへファイル保存します。参照スナップショットを保存する 

 

Save As... 

 

Ctrl+Shift+S 
現在の画像のスナップショットを新しい名前、形式でファイル保存

します。参照スナップショットを保存する 

 

Print Setup... 

 

Ctrl+Shift+P 
プリンター設定画面を開き、プリンターの選択やプリンターオプ

ションの設定を行います。 
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Menu item Shortcut Description 

Print Ctrl+P 現在の画像のスナップショットを印刷します。参照スナップショット

を印刷する 

 

Exit 

 アプリケーションを閉じ、Epiphan Capture Toolのこのインスタンス

を介して実行されたすべてのキャプチャと保存を終了します。 

 

Edit メニュー (Windows)  
 

The Edit menu has these options: 
 

Menu item Shortcut Description 

 

Copy 

 

Ctrl+C 
現在の画像のスナップショットをクリップボードにコピーしま

す。参照 スナップショットをコピーする 

 

View メニュー   
 

The View menu has these options: 
 

Menu item Shortcut Description 

Toolbar  ツールバーアイコンのサイズ変更や非表示/表示の設定を行います。 (ツール

バーが非表示（Hide）になっている場合、サイズを選び復元します) 
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Menu item Shortcut Description 

   

 

 

Status Bar 

 アプリケーション画面下部にあるステータスバーを表示/非表示にします。 
 

 

 

Full Screen 

 

Ctrl+F 
フルスクリーンモードを有効にします。Escキーで元の画面モードに戻りま

す。 

 

 

 

Image Only 

 

 

 

(ESC to exit) 

ツールバー、ステータスバー、メニューバーを表示させずに、画像のみの

表示にします。(スクロールバーは継続して表示される場合があります) 

このモードはEpiphan Capture ToolとカスタムのシステムUIとを連携させる

場合に役立ちます。既存のショートカットキーは引き続き使用できます。 

Escキーで元の表示モードに戻ります。 

 

Capture メ ニ ュ ー   

Captureメニューはキャプチャ/録画の開始、停止、一時停止を行います。また、ビデオキャプチャワークス

テーションに複数のビデオグラバーが装着されている場合に、アプリケーションのこのインスタンスで動作

するDVI2PCIe Duoを選択することもできます。 
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The Capture menu has these options: 
 

Menu item Shortcut Description 

Start 

Recording 

(Stop 

Recording) 

 

Ctrl+R 

 

キャプチャされたストリームを映像、または一連の画像として保存を開

始、停止します。参照 映像保存 と一連の画像として保存する 

Pause Capture 

(Resume 

Capture) 

 

Ctrl+U 

 

キャプチャや保存を一時停止/一時停止解除します。（キャプチャされた

最後のフレームが画面上に表示されたままになります）参照ビデオキャプ

チャを一時停止する 

 

Select Device... 

 

Ctrl+N 

ビデオキャプチャワークステーションに複数のビデオグラバーが接続され

ている際、または複数の映像ソースが接続されている際に、どのビデオグ

ラバーを使用するか、どのソースを使用するかを指定します。 
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Menu item Shortcut Description  

   

 

 

 

 

 

 

 

 

 

 

Epiphan Capture Toolのこのインスタンスで使用したいデバイスまた

は入力を選択し、OKをクリックします。 

Connect 

Network 

Device... 

  

 

 

 

DVI2PCIe Duoでは適用されない機能で、既に販売終了した

VGA2Ethernetで使用できます。 

Disconnect 

Network 

Device 

Recent 

Network 

Devices 

Enable Audio 

Capture 

(Disable Audio 

Capture) 

 

Ctrl+A 

 

有効にすると、デバイスまたは設定された外部音声ソースにからの音声が

キャプチャされ、その音声は映像保存に含まれます。参照 音声設定 

Audio 

Input Device 

 サブメニューを開き、音声キャプチャに使用する入力デバイスを選択し

ます。参照 音声設定  
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Play 

Captured Audi 

o 

 有効にすると、ビデオキャプチャワークステーションでキャプチャさ

れた音声を再生します。（スピーカーや接続しているヘッドフォンか

ら確認できます）映像保存での音声をモニタリングしたり、キャプチ

ャしている音声をローカルの視聴者と共有したりします。 

Play Captured Audio 設定を有効にするには、Enable Audio Captureを有効

にする必要があります。 

Configure 

Device... 

 

Ctrl+Shift+C 
ビデオグラバーの特定のキャプチャ調整を設定するための画面を開きま

す。参照デバイス設定 

 

Tools メニュー  

Epiphan Capture ToolのToolsメニューでは、カスタムEDIDのアップロード、アプリケーションオプションの設

定ができます。 
 

The Tools menu has these options: 
 

Menu item Shortcut Description 

 

Upload EDID to Device... 

 ビデオグラバーにカスタムEDIDをアップロードしま

す。参照  EDIDをアップデートする (このオプション

はSDIソースには適用されません。) 

 

Read EDID from Device... 

 ビデオグラバーのEDIDを読み出します。 
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Measure VGA Mode... 

 技術的なサポートの際に必要になった場合に使用して、問

題の原因を探るための簡単な情報を表示できます。ご提供

いただく際は、この情報を電子メールにコピーしてくださ

い。 

 

Upgrade EDIDs for all Devices 

 メーカーは、ビデオグラバー用に汎用EDIDを随時リリース

しています。このツールを使用してアップグレードを確認

し適用します。（このオプションはSDIソースには適用さ

れません） 

 

 

Upgrade Grabber Firmware 

 メーカーは、ドライバとビデオグラバーファームウェア

を随時リリースします。このツールを使用して、アップ

デートを確認し、適用します。アップデートがある場合

は、新しいドライバがコンピュータにインストールさ

れ、それらのドライバがファームウェアをDVI2PCIe 

Duoにロードします。 

 

Options 

 映像のキャプチャ、録画などに関連するいくつかのオ

プションを設定できます。使用可能なオプションの詳

細については、アプリケーションオプション をご参照

ください。 

 

アプリケーションオプション 

Epiphan Capture ToolにはTools » Optionsメニューからアクセスできる有効なオプション設定がいくつか

あります。 

以下にある、Recording, On-Screen Text、KVM、 Sharing、Display、Capture、Audio、

Startupのカテゴリーがあります。 
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The Options dialog has these tabs: 
 

Menu item Description 

 

 

Display 

キャプチャツールでキャプチャされた画像を表示する方法と、ステータ

スバーに表示される情報を設定します。表示形式に関しては、表示オプ

ション設定 を、ステータスバーの詳細については、ステータスバー をご

参照ください。 

 

 

Capture 

クロッピングの設定をします。（画像のある一部分だけをキャプチャす

るため）参照 キャプチャ画像をクロップする  

その他、このタブからビデオモードの検出試行のインターバルを変更す

ることもできます。数値を小さくすると、ビデオグラバーは別のビデオ

モードをより頻繁にチェックを行いますが、グラバーの動作が激しくな

るため、フレームレートが低下する可能性もあります。 

また、キャプチャのフレームレートを制限することもできます。これ

は、ストリーミングや録画をしている際、帯域幅（またはディスク容

量）が少なく、データ量を抑えたい場合に必要になることがあります。 

 

 
Audio 

録画の音声形式、使用する音声ソース、キャプチャワークステーションの

音声出力デバイス（音声キャプチャのモニタリングに使用するスピーカ

ー、ヘッドフォンなど）でキャプチャした音声をEpiphan Capture Toolが

再生するかを設定できます。参照 音声設定  

 

 

Startup 

Epiphan Capture Toolがフルスクリーンモードで起動するかを選択しま

す。 

このタブのその他のオプションは販売終了製品（VGA2Ethernetな

どのネットワーク接続のビデオグラバー）でご利用いただくもので

す。 

 

Recording 

画像や映像として保存するようにキャプチャアプリケーションの保存

機能を設定できます。参照 映像保存、録画のオプション設定、一連の

画像として保存する  

 

On-Screen Text 

Epiphan Capture Tool を使用すると、キャプチャしたフレームにテキス

トを追加できます。このタブでは、そのテキスト内容を設定できます。参

照 文字の追加 

KVM This feature is not used by DVI2PCIe Duoではこちらの機能は使えませ
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ん。KVM2USB用のものです。 

 

Help メニュー  

Epiphan Capture ToolのHelpメニューで、ソフトウェアアップデートの確認、製品登録、現在のソフトウ

ェアのインストールに関する情報が確認できます。 

 
 

Help » Check for Updates メニューで、Epiphan Capture Toolやドライバ のアップデートを確認できます。ソ

フトウェアのアップデートバージョンがある場合もありますが、新しい機能が追加されたり、使用している

ビデオグラバーのモデルが更新されたりすることはありません。このような場合、ソフトウェアの更新チェ

ックではアップデートは推奨されませんが、ドライバとソフトウェアのアップグレードに記載している方法

でソフトウェアをアップデートできます。 

https://www.epiphan.com/products/kvm2usb/
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ツールバー 

The Epiphan Capture Toolのツールバーにはキャプチャの開始、停止、一時停止、スナップショット

の保存など、よく使用される機能のクイックアクセスボタンが用意されています。 

ツールバー 
 

メニューのView » Toolbar » (size) からツールバーのアイコンの大きさを変更できます。 

View » Toolbar » Hide Toolbarでツールバーを非表示にでき、ツールバーアイコンのサイズを選択する

ことで、ツールバーが再表示されます。 

The toolbar items: 
 

Icon 

(Windows) 
Description 

 

 

現在のキャプチャフレームのスナップショットを保存します。最初にキャプチャを一

時停止することをおすすめします。参照 スナップショットのコピー、保存、印刷  
 

 

現在のキャプチャフレームを印刷します。最初にキャプチャを一時停止することをおす

すめします。参照スナップショットのコピー、保存、印刷  

 

 

クリップボードに現在のキャプチャフレームをコピーします。最初にキャプチャを一時停

止することをおすすめします。参照 スナップショットのコピー、保存、印刷 

 

 

キャプチャフレームの保存を開始 (または停止)します。（画像や映像形式で）参照  

映像保存 と一連の画像として保存する 

 

 

 

キャプチャや録画を一時停止します。（録画ファイルは閉じます） 

 

 

音声キャプチャを有効、または無効にします。参照 音声設定  
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スナップショットのコピー、保存、印刷 

Epiphan Capture Toolを使って、ストリームからスナップショットのコピー、保存、印刷ができます。 

 

スナップショットを保存する 

以下のいずれかの方法で、キャプチャしているストリームを.bmp、.jpg、.png の形式で保存できます。オ

プションで、画像を保存する前にビデオキャプチャを一時停止できます。参照 ビデオキャプチャを一時停止

する  

⚫ File » Save を選択する 

⚫ Ctrl+S を押す 

⚫ ツールバーの保存アイコンを使う 
 

初めてスナップショットを保存すると、[名前を付けて保存]ダイアログが開き、ファイル形式と保存先を

指定します。File » Save As...または ショートカットキーCtrl+Shift+S を使用しない限り、後続の画像

はこのファイルを自動的に上書きします。 

 

スナップショットを印刷する 

以下のいずれかの方法で、ストリームから直接スナップショットを印刷できます。オプションで、画像を保存

する前にビデオキャプチャを一時停止できます。参照 ビデオキャプチャを一時停止する  

⚫ File » Print を選択する 

⚫ Ctrl+P を押す 

⚫ ツールバーの印刷アイコンを使う 
 

 

メニューオプションの File » Print Setup...または、ショートカットキー Ctrl+Shift+P でプリンターを選択

し、プリンターを設定します。 

オプションとして、印刷時の色を反転することができます。（黒は白、黄は青、赤はシアンなどで表示され

ます）印刷の色を反転するには: 

1. Tools » Options を選択する 
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2. Display タブを選択する 

3. Invert colors for printing のチェックボックスにチェックを入れる 

 
 

4. OKをクリックする 

 

スナップショットをコピーする 

以下のいずれかの方法で、ストリームのスナップショットをクリップボードに簡単にコピーできます。オプ

ションで、画像を保存する前にビデオキャプチャを一時停止できます。参照 ビデオキャプチャを一時停止する  

⚫ Edit » Copy を選択する 

⚫ Ctrl+C を押す 

⚫ ツールバーのコピーアイコンを使う 

 

ワークステーションで別のアプリケーションを開き、貼り付け（Edit » Paste や Ctrl+Vなど）をする

と、クリップボードにコピーした画像が貼り付けられます。 
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映像保存（録画） 

Epiphan Capture ToolでDVI2PCIe Duoからキャプチャされた画像を映像として保存できます。 

音声キャプチャの選択もでき (参照 音声設定)、映像の変わりに個々の画像ファイルを保存すること

もできます。参照  一連の画像として保存する 

キャプチャした映像ソースを録画するには: 

 

Step 1: コーデックを設定する 

エンコーディングコーデックを選択してください。コーデックはDVI2PCIe Duoからビデオフレームを非圧縮

で受け取り、それらを組み合わせデジタルビデオファイルに圧縮して、プレーヤーで表示したり、他者と共有

したり、YouTubeなどの動画サイトに映像をアップロードしたりできるソフトウェアです。 

初期設定では、OSにはいくつかのコーデックがインストールされており、Epiphan Capture Toolには追加の

コーデックは用意されていません。x264などのサードパーティコーデックをインストールするとそれを選択

できるようになります。最適なコーデックを選択することはこのユーザーガイドの範疇を超えますが、イン

ターネット上でコーデックに関する多くの情報を見つけることができます。 

コーデックを設定するには: 

1. ビデオグラバーをキャプチャワークステーションに装着する 

2. ビデオグラバーに映像ソースを接続する 

3. Epiphan Capture Toolを起動する 参照 Epiphan Capture Tool. 

4. Tools » Options メニューを選択し、 

a. Recording タブを選択する 
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b. Record asのドロップDownでVideoを選択していることを確認する  

c. Select Codec... ボタンを押し、OSにインストールされているコーデックを選択し、OKをクリックす

る。圧縮プログラム画面が閉じます。 
 

d. 必要に応じて、AVIファイルのサイズ制限（AVI file size limit）を変更する。指定したファイ

ルサイズに達すると録画が自動的に停止します。 

e. このタブでファイル名や録画時間など、録画のオプション設定 も設定できます。 

f. OKをクリックし、録画設定を保存する 

 

Step 2: 録画 

Epiphan Capture Toolで 適切に設定ができれば、後は録画をするだけです。 
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ビデオグラバーによってキャプチャされた画像/フレームは映像ファイルに保存されます。ステータスバーに

はファイル名、ファイルの保存先、録画の経過時間、録画されたフレーム数が表示されます。 

映像を録画する: 

1. Epiphan Capture Toolは映像ソースをキャプチャして表示されているはずです。 (もしNo Signal とい

うメッセージが表示されていたら、ケーブルを抜き挿しし再接続し、全て正しく接続がされているか確

認します。) 

2. オプションとして、音声キャプチャを設定し、有効にする。参照 音声設定 

 

3. Capture » Start Recordingを選択するか、赤い録画ボタン、またはキーボードショートカットキー

のCtrl-Rで録画を開始する。[保存]ダイアログが開きます。  
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4. ファイル名とファイルの保存先フォルダを指定する。 (参照 録画のオプション設定 ) 

5. キャプチャが完了したら、一時停止/停止ボタンで、録画を一時停止/停止する。 (キーボードショート

カットキーCtr+Uで一時停止でき、またはメニューのCapture » Pause か Capture » Stop Recording

で録画を制御することもできます。) 

 

6. OSのファイルブラウザで (Windows Explorer や Finder) 保存したファイルを見つける。ステータスバー

が表示されている場合、最後に保存されたファイル名とパスがEpiphan Capture Toolの下部にあるステー

タスバーに表示されます。 

 

AVIファイルサイズ制限に達すると、録画設定に従って以下のいずれかが発生します。 

⚫ 録画が停まる 

⚫ 新しいファイルを作成し、録画が継続する 

⚫ 最初のファイルを上書きし、録画が継続する 

録画設定オプションに関しては録画のオプション設定をご参照ください。 

デバイスが古い、または正しいEDIDがロードされていない場合、HDMI音声キャプチャが失敗す

る場合があります。参照 EDIDをアップロードする 
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キャプチャ画像をクロップする 

キャプチャにおいて、DVI2PCIe Duoでキャプチャされた画像全体を保存することが多いですが、時折、

いくつかの情報(機密情報や個人情報)を削除したり、黒帯やソースの中の不要な部分を切り取ったりした

いことがあります。そのような場合にEpiphan Capture Toolで、画像や映像を保存する前にキャプチャさ

れたソースをクロップすることができます。 

例えば、クロップ機能を使用すると、下の左側の画像を右側の画像のようにキャプチャ画像の表示を変更

できます。ステータスバーにはクロップされた座標が表示されます。 

 

 

キャプチャのクロップ設定をする前にまず、クロッピングパラ

メータを指定するために映像保存を行います。 

1. Tools » Options から Capture タブを選択する 

2. Enable hardware cropping のチェックボックスにチェックを入れる 
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3. Width (幅) と Height (高さ)にキャプチャしたいクロップ範囲のピクセルサイズを指定する 

4. Using the Left (左) と Top (上) にキャプチャを始めたい左隅のピクセルを指定する。これらの値を変更する

と、画像の見える部分がクロップ範囲で変化するのを確認できます。 

5. Applyをクリックし変更を確認し、微調整をするかOKで変更を保存する 
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EDIDをアップデートする 

EDID  (Extended display identification data) は映像表示デバイス(通常はモニター)によって提供されるデータ

で、映像ソース(通常はPCやその他のデバイスのグラフィックスや映像出力)へ伝えられます。映像ソースはその

EDIDを受け取り、モニターが対応している解像度、色深度、その他の設定を決定します。 

DVI2PCIe Duoの場合、映像ソースに対してモニターのように機能します。対応する全てのビデオモードの

情報を持った包括的なEDIDを工場出荷時にロードされています。映像ソース(PCやビデオカメラなど)を接

続すると、この映像ソースはDVI2PCIe Duoをモニターとして認識しそのEDIDを受け取り、送る映像信号を

ネゴシエートします。 

通常、工場出荷時にロードされているEDIDで、対応している映像ソースに対しうまく機能するはずですが、

ご使用の映像ソースが表示プロパティのカスタム設定を行っている場合があり、そのような場合はPC、カメ

ラ、その他の映像ソースに必要な解像度や色深度などを指定するため、キャプチャカードにカスタムEDIDを

アップロードする必要があります。 

 

特定のEDIDをロードする必要があることに加え、時にメーカーの最新工場出荷時のEDIDをキャプチャデバ

イスにアップロードしたい場合も考えられます。 

新しいEDIDをアップロードする 

ほとんどの場合、工場出荷時にインストールされたEDIDで十分ですが、映像ソースが使用したくない解像度

を使用している場合があります。その場合、ビデオグラバーに特定の属性を持たせるためEDIDを選択できま

す。 

1. 新しいEDIDファイルをダウンロードするためEpiphan support へアクセスする 

2. Select a productのドロップダウンからDVI2PCIe Duoを選択する 

3. Softwareページを開き、EDIDリストまでスクロールする 

例えば、 1040x768のみで動作するようにDVI2PCIe DuoにカスタムEDIDをアップロードできます。

映像ソースがビデオグラバーからのEDIDを受け取ると、映像ソースはEDIDで設定された1024x768で

映像出力するようにリセットされます。 

EDIDはDVIソースにとっては重要ですが、VGAソースではほぼ無視されます。 

EDIDの変更は他のEDIDに置き換えられるまで適用されます。 

https://www.epiphan.com/support
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4. リストからEDIDをクリックする。ハードドライブのダウンロードにファイルが保存されます。 

 

5. キャプチャワークステーションにビデオグラバーを接続する 

6. ビデオグラバーに映像ソースが接続されていないか確認する 

7. Epiphan Capture Toolを起動する 

8. Tools » Upload EDID to device... を選択する。ファイル選択ダイアログが開きます。 
 

9. 開いたダイアログからダウンロードしたEDIDファイルを見つけ、選択する 

10. ソースが接続されていないことを確認するメッセージが開き、ビデオグラバーに何もソースが接続さ

れていないことが確認できれば、OKをクリックする 

11. しばらくすると、EDIDのアップロードが完了する 

工場出荷時のEDIDに戻すには、ダウンロードリストの"default configuration" EDID を選

択します。 
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EDIDの実用例 

ここではキャプチャの問題をカスタムEDIDで解決する方法例を紹介します。 

固定解像度640×480の映像出力デバイスとして接続されたフラットパネルモニターがあるとします。そ

のフラットパネルモニターとDVI2PCIe Duoを交換すると、映像ソースからの出力解像度が720×400に

変わりました。 

なぜ解像度が変わったのかというと、映像ソースが720×400の解像度を優先させたためです。もともとフラ

ットパネルモニターが720×400に対応していなかったため、映像ソースは640×480で出力することになった

のです。しかしDVI2PCIe Duoは720×400に対応しているため、自動的に優先解像度に変わったのです。 
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表示オプション設定 

Epiphan Capture Toolはキャプチャされたフレームをどのように表示するか、いくつか設定できます。例え

ば、アプリケーション画面を大きくしたり小さくしたりするときに画像もスケーリングするかどうか、画面上

で画像を回転させるかどうかを選択できます。 

表示オプション 

これらのオプション設定へは、Epiphan Capture ToolのメニューTools » Options、Display タブの選択で

アクセスできます。 
 

以下に利用可能な表示設定項目を紹介します。ステータスバーに関しては別途記載しています。参照ス

テータスバー 
 

Menu item Description 

 

 

Display format 

キャプチャに使用するカラースペースを変更できます。カラースペース

はキャプチャした映像の見え方と、キャプチャできる最大フレームレー

トに影響します。カラースペースの変更はアプリケーション画面上の表

示と保存される内容に影響します。 

Epiphan Capture ToolはいくつかのRGB、グレースケールカラーフォー

マットに対応していますが、YUV4：2：0カラースペースに対応したサー
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ドパーティアプリケーションを使用した場合、DVI2PCIe Duoはそのカラ

ースペースでもキャプチャできます。 

 

1080p/60 fpsの場合、YUV4：2：0に対応したサードパーティア

プリケーションを利用する必要があります。  

 

 

 

Image scaling 

キャプチャアプリケーション画面のサイズにキャプチャした画像を自動

的にダウンスケールするかどうかを選択します。Offにすると画像がキャ

プチャアプリケーション画面よりも大きい場合、スクロールバーが表示

されます。 

この設定は表示にのみ適用され、画像・映像保存のフレームサイズには

影響しません。 

 

 

Image rotation 

必要であれば、Epiphan Capture toolでキャプチャしたソースを回転で

きます。もしカメラやソースを左右に90度、180度回転させる必要があ

る場合に有効です。ドロップダウンリストから回転角度を選択し、き

ちんと表示されていることが確認できればApplyをクリックします。 

この設定は表示と保存された画像/映像の両方に影響します。 

Resize window on resolution 

change 

チェックを入れると、ソースの解像度を変更するとアプリケーショ

ン画面のサイズが変更されます。 

 

Invert colors for printing 
チェックを入れると、印刷の色が反転します。黒は白に、黄は青に、赤

はシアンに、などで印刷されます。 

 

 

Flip image vertically 

チェックを入れると、画像が垂直方向に反転します。 

画像を水平方向に反転するには、このオプションを選択した上で、180

度の画像回転を行います。 

この設定は表示と保存された画像/映像の両方に影響します。 
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追加機能 

ここでは、その他に役立つ機能を紹介します。 

 

ステータスバー  

Epiphan Capture Toolはステータスバーがあり、DVI2PCIe Duoや現在選択しているビデオグラバーに関

する情報が確認できます。設定や状況によってステータスバーに追加される表示について、以下をご参

照ください。 

接続されているビデオグラバーがない 

アプリケーションが接続されているビデオグラバーを見つけていない場合、ステータスバーにはcapture 

devices not found（キャプチャデバイスが見つからない）と表示されます。 

 

選択されているビデオグラバーからの信号がない 

現在、選択されているビデオグラバーへ何も信号がない場合、ステータスバーには no signalのメッセージ

が表示されます。 

 

準備はできているか録画はしていない 

それ以外の場合、ステータスバーには様々な情報が表示されます。録画中ではない場合、ステータスバーに

は録画開始準備ができている(Ready) ことを示すメッセージが表示され、バーの右側にはソース信号のVGAモ

ードが表示されます。t 

 

映像保存(録画)中 

初期設定では、録画が始まるとこのように、それぞれが追加で表示されます。 (RECORDING、ファイ

ル保存先、録画経過時間とフレームカウント) 
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映像保存(録画)完了 

録画が完了すると、ステータスバーは更新され、ファイルの保存先と録画時間が表示されます。アプリケーシ

ョンを閉じるか、録画を再開するまでステータスバーはこのままです。 

 

画像保存 

一連の画像として保存すると、ステータスバーには RECORDING、現在のファイル名が表示されます。 

 

画像保存完了 

画像保存が完了すると、ステータスバーには保存された画像フレーム数が表示されます。 
 

 

オプション情報 

ステータスバーにはTools » Options » Displayで設定された内容に応じて、他の情報も表示できます。ステ

ータスバーには以下のようにそれぞれを個別に表示させることもできますが、すべて同時に表示することもで

きます。すべての情報を表示するにはアプリケーション画面の横幅が十分である必要があります。 

⚫ 現在のキャプチャフレームレート 
 

⚫ 左上隅(以下の0，0)、右下隅(以下の1920，1080)、フレームサイズを示すクロップ範囲 

 

⚫ 音声エンコーディング情報 
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⚫ アプリケーションが起動してからビデオグラバーがキャプチャしたフレーム、画像の数 

 

ビデオキャプチャを一時停止する  

ツールバーの一時停止ボタン、メニュー、キーボードショートカットキーCtr+Uでキャプチャを一時停止で

きます。キャプチャを一時停止すると以下のことが起こります。 

⚫ Epiphan Capture Tool上では最後にキャプチャされたフレームが表示されたままになります。（新

しいフレームは取得されません）この画像は保存、コピー、印刷ができます。参照 スナップショッ

トのコピー、保存、印刷 

⚫ 録画していた場合: 

⚫ 録画は終了します 

⚫ もし自動で再開する（Automatically restart recording）にチェックが入っていない場合

（Tools » Options、Recordingタブで設定できます)、 録画は終了し、ファイルが生成され

ます。 

⚫ もし自動で再開する（Automatically restart recording）にチェックが入っている場合

（Tools » Options、Recordingタブで設定できます)、もう一度一時停止ボタンを押す

か、Capture » Resume Captureで一時停止が解除され、設定に応じてファイルを上書き

するか、新しいファイルで録画を再開します。参照録画のオプション設定 

⚫ 画像保存をしていた場合: 

⚫ 画像保存は停止します 

⚫ もう一度一時停止ボタンを押すと、すぐにキャプチャが再開します 

キャプチャの一時停止はライブストリーミング中も便利です。 

 

一連の画像として保存する  

 Epiphan capture tool と DVI2PCIe Duoを使って録画する方法は２つあります。個々の画像をキャプチャ

する、または映像をキャプチャする、の２つです。映像をキャプチャするについては 映像保存をご参照

ください。 

一連の画像として保存する場合、音声はキャプチャできません。 
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一連の画像として映像ソースをキャプチャする 

Step 1: キャプチャモード、ファイル形式、キャプチャ周期を設定する 

初期設定では、Epiphan Capture Tool はVideo形式で録画するようになっているため、画像保存を開始す

る前にモード変換を忘れないでください。  

画像保存モードとファイル形式の設定: 

1. ビデオグラバーをキャプチャワークステーションに接続し、キャプチャワークステーションを起動する 

2. ビデオグラバーと映像ソースを接続する 

3. Epiphan Capture Toolを起動する 

4. Tools » Options メニューを選択する 

5. Recording タブを選択する 
 

6. Ensure the Record as のドロップダウンから Images が選択されているか確認する 

7. Format ドロップダウンからBMP、PNG、JPEG (JPG)のいずれかを選択する 
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8. Save options で: 
 

 

a. ファイルを保存するフォルダを指定する。フォルダを指定しない場合、Epiphan Capture Tool 

と同じフォルダに保存されます。 

b. 必要に応じて、ファイルのプレフィックス(Prefix)を指定する 

c. サフィックス(Suffix)ドロップダウンで、サフィックスに10進数（d）または16進数（X）のどち

らの文字を使用するか、ファイル名に先行するゼロの数（たとえば、％04dは4桁の10進数のサ

フィックスで、最初に保存されるいくつかのファイルは3つの先行ゼロ（cap_0001.bmp）とな

ります）を決定します。 

d. Startで、保存ファイルに使用する最初の値を設定する 

e. Exampleで、ファイル名設定の内容を確認する 

f. 上書き保存をする場合は、Overwrite existing files のチェックボックスにチェックを入れる 

g. 画像が保存されたかどうかに関わらず保存を続行したい場合は、Ignore write failures のチェックボックス

にチェックを入れる。 (ここにチェックを入れると、ディスクスペースが不足した場合、またはフ

ァイルの書き込みを妨げるアクセス許可の問題が発生した場合に警告が表示されません) 

9. 画像保存の間隔を設定する。全フレームを保存すると最大1秒あたり30フレーム保存されます

が、ハードドライブの空き容量がすぐにいっぱいになる可能性があります。 

 

10. 各全フレームを画像として保存する場合は、Save all frames を選択する 

11. Xフレームおきに画像を保存する場合は、Skip と値を設定する(Skip と 10 を設定すると、10フレー

ムおきに画像が保存されます) 

12. 画像保存のインターバルを設定する場合は、Wait と値を設定する。数秒、数分ごとに１フレーム

を保存します。(単位はミリ秒、秒、分、時間から選べます) 
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13. Automatically turn recording offで、画像保存を自動で終わるかを設定できます。特定枚数のフレームが

保存されたら停止する、または録画開始からの経過時間が来ると停止するかを選ぶ。 

 
 

14. 録画ボタンなどで画像保存を停止する場合は、Automatically turn recording off のチェックを入れない 

15. 設定を保存するため、適用をクリックし、OKで設定画面を閉じる 

Step 2: 録画 

Epiphan Capture Toolで設定ができれば、一連の画像として保存ができるようになります。 

ビデオグラバーにキャプチャされた画像/フレームは個々の画像ファイルとして保存されます。キャプチャの

間、ステータスバーには最後に保存された画像のファイル名と保存先が表示されます。保存された画像の合計

数は録画が終了したときに表示されます。 

画像保存: 

1. 映像ソースが接続されていれば、Epiphan Capture Toolはすでに映像ソースをキャプチャし、プレビュ

ーしているはずです。No Signal メッセージが表示されていた場合、すべての接続が正しくできている

かどうかケーブルの抜き差しなどで確認します。 
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2. Capture » Start Recording、録画ボタン、キーボードショートカットキーCtrl+Rで録画を開始する。

保存ダイアログが開きます。 

 

3. 画像保存が終了したら、一時停止か停止で録画を停止する。キーボードショートカットキーCtrl+U

で一時停止、Capture » Pause または Capture » Stop Recording で録画を停止することもできます。 

 

4. OSのファイルブラウザで (Windows Explorer や Finder)保存した画像ファイルを探す 

 

音声設定  

DVI2PCIe Duo は暗号化されていないHDMIやSDIソースから直接音声をキャプチャできます。Epiphan 

Capture Tool はキャプチャワークステーションに接続されている他の音声デバイス(PCに内蔵されているマイク、

USBやオーディオジャック経由で接続された外部マイクなど)から音声をキャプチャすることもできます。 

初期設定でしゃ、Epiphan Capture Tool の音声キャプチャは無効です。 

Step 1: 音声ソースを選択する 

音声ソースの選択は、Tools » Options メニューか、Capture メニューから設定できます。 

音声ソースを選択するには: 

1. OS内蔵の外部音声ソースを設定する(通常、内蔵マイクの設定は不要です) 

2. または、HDMI や SDIソースをビデオグラバーに接続する 

3. Epiphan Capture Toolを起動する 

4. Tools » Options メニューを選択する 

a. Audio タブを選択する 
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a. エンベデッドHDMI や SDI 音声をキャプチャする場合は、Frame Grabberを選択する 

b. 外部音声ソースを利用する場合は、Specific Windows audio input deviceを選択する 

c. 必要に応じて、Audio format ドロップダウンから、保存(または、ストリーム)したい特定の音声

ビットレート、Stereo/mono、ビット深度 を選択する。 (この値が音声ソースのビットレートと

異なる場合、DVI2PCIe Duo は指定したビットレートにリサンプリングします。) 

d. 必要に応じて、check the Play captured audio のチェックボックスにチェックを入れ、キャプチャ

ワークステーションの音声出力デバイス(スピーカー、接続したヘッドフォンなど)から音声を再生す

る。 

e. 適用をクリックし、ＯＫで設定画面を閉じる 

5. または、Capture » Audio Input Deviceのリストから音声ソースを選択する 
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Step 2: 音声キャプチャを有効にする 

ツールバーを見ると、音声キャプチャが有効になっているかどうかが分かります。スピーカーアイコン

がそのまま(音波が出ていない状態)であれば音声キャプチャは無効です。下図をご参照ください。 

 

Audio enabled Audio disabled 

 

 

 

 

 

 
 

音声キャプチャを有効にする: 

1. Epiphan Capture Toolを起動する 

2. ツールバーのスピーカーアイコンをクリックする; 音声キャプチャが有効になり、スピーカーアイコンが

音波を出しているような動きになります。 

音声キャプチャを無効にする: 

1. ツールバーのスピーカーアイコンをクリックする; スピーカーアイコンの動きがとまります 

Step 3: キャプチャ 

ツールバーの録画ボタンで音声/映像ストリームをキャプチャします。 
 

デバイスに古いまたは正しくない EDID がロードされていると、HDMI音声キャプチャが失敗

する場合があります。参照 EDIDをアップデートする 
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録画のオプション設定  

映像保存で記載している通り、映像としてキャプチャされたフレームを録画する際、いくつかのオプション設

定があります。 

自動でファイル名を設定する (自動再開) 

録画と一時停止を使ってEpiphan Capture Tool で前のファイルを上書きするか、最初に録画を開始するときに

指定するファイル名に追加されるサフィックスを作成するように設定することで、録画するたびにファイル名

を入力する必要がなくなります。 

ビデオグラバーをキャプチャワークステーションに接続し、ビデオグラバーにソースを接続します。Epiphan 

Capture Toolを起動し、必要に応じて、映像保存の手順に従い録画設定を行います。 

録画の度に同じファイルに上書きする: 

1. Tools » Options » Recording タブで、Automatically restart recording のチェックボックスにチェックを入れる 

 

 

2. Overwrite the same file (old content will be lost) にチェックを入れる 

3. 適用をクリックする 

4. 録画を開始し、映像ファイルの保存先と名前を指定する 

5. 録画中に、ツールバーの一時停止ボタン (キーボードショートカットキー Ctrl+U か Capture » 

Pause )で録画を停め、もう一度押して再開する。前のファイル名で自動的に上書きされます。 

一連の映像ファイルとして保存する (それぞれに異なるサフィックスを持たせる): 

1. Tools » Options » Recording タブで、Automatically restart recording のチェックボックスにチェックを入れる 
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2. Create a new file every time recording is restarted にチェックを入れる 

3. Suffix ドロップダウンで、サフィックスに10進数 (d)、または16進数 (X) のどちらを使用するか、

ファイル名に先行するゼロ(0)の数を指定する ( %04d は４桁 10進数のサフィックスで、最初の数

ファイルには３つのゼロ (000) が 付きます(cap_0001.bmp)) 

4. オプションとして、一連のファイルの最初に付ける値を選択する 

5. オプションとして、同じ名前のファイルが既にある場合に、ファイルを自動的に上書きする場合は、

Overwrite existing files (既存のファイルを上書きする)にチェックを入れる 

6. 適用をクリックする 

7. 録画を開始し、映像ファイルの保存先と名前を指定する 

8. 録画中に、ツールバーの一時停止ボタン (キーボードショートカットキー Ctrl+U か Capture » 

Pause )で録画を停め、もう一度押して再開する。一連の映像保存の中で新しい映像ファイルを自動

的に作成します。 

録画時間を設定する 

必要に応じて、指定した時間が経過した後、または指定したフレーム数が保存されたときに録画を停止する

ようにEpiphan Capture Toolを設定できます。例えば、超音波装置からの映像信号を録画するとき、常に1分

の録画が必要になる場合などに利用できます。 

ビデオグラバーをキャプチャワークステーションに接続し、ビデオグラバーに映像ソースを接続します。

Epiphan Capture Toolを起動し、必要に応じて、映像保存の手順に従い録画設定を行います。 

録画の度に同じファイルに上書きする: 

1. Tools » Options » Recording タブで、Automatically restart recording のチェックボックスにチェックを入れる 
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2. チェックを入れ、ある数のフレームが保存された後（frames have been saved）、または指定さ

れた時間が経過した後（elapsed）に停止するように指定する。 

3. 制限値を入力する: フレーム数、または時間 (単位：ミリ秒、秒、分、時間 ) 

4. 適用をクリックする 

5. 録画を開始すると、設定した制限がくると自動的に録画は停止します。 

文字の追加  

Epiphan Capture Toolでキャプチャした画像や映像の上にタイムスタンプなど固定の文字をオーバーレイで

追加できます。 

タイムスタンプを追加する 

予め用意された形式の中からフォント、サイズ、位置、色を選択し、キャプチャされた映像にタイムスタ

ンプを追加できます。 

ビデオグラバーをキャプチャワークステーションに接続し、ビデオグラバーに映像ソースを接続します。

Epiphan Capture Toolを起動し、必要に応じて、映像保存の手順に従い録画設定を行います。 

タイムスタンプを追加する: 

1. Tools » Options から On-Screen Text タブを選択する 

2. Timestamp チェックボックスにチェックを入れる 
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3. Format ドロップダウンからタイムスタンプの形式を選択する 

4. 必要に応じて、文字の色(Color、初期設定では白)、アウトラインの色(Outline、初期設定ではグレー)を

変更する 

5. Position のグリッドの中から、タイムスタンプを表示したい位置をクリックする 

6. Font の横にある(...)をクリックしてフォントと大きさを変更する 

7. 設定ができれば、適用をクリックし表示を確認する。そのままでよければOKをクリックして設定画

面を閉じる。 

注：タイムスタンプも固定の文字もどちらも追加できます。 

固定の文字を追加する 

フォント、サイズ、位置、色を選択して、固定の文字をキャプチャした映像に追加できます。 

ビデオグラバーをキャプチャワークステーションに接続し、ビデオグラバーに映像ソースを接続します。

Epiphan Capture Toolを起動し、必要に応じて、映像保存の手順に従い録画設定を行います。 

固定の文字を追加する: 

1. Tools » Options から On-Screen Text タブを選択する 

2. Static text のチェックボックスにチェックを入れる 
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3. Text 欄に文字を入力する 

4. 必要に応じて、 文字の色(Color、初期設定では白)、アウトラインの色(Outline、初期設定ではグレー)を

変更する 

5. Position のグリッドの中から、文字を表示したい位置をクリックする 

6. Font の横にある(...)をクリックしてフォントと大きさを変更する 

7. 設定ができれば、適用をクリックし表示を確認する。そのままでよければOKをクリックして設定画

面を閉じる。 

固定の文字、タイムスタンプの両方をキャプチャした映像や画像にオーバーレイできます。 

 

コマンドラインオプション  

コマンドラインオプションを使用して、Epiphan Capture Tool の起動方法を制御できます。必要な数のコ

マンドラインオプションを任意の順序で追加します。各コマンドラインオプションは 2つのダッシュで始ま

り、スペースで他のオプションと区切られます。

カスタムフォントジェネレーターを使用して、会社のロゴまたはその他のグラフィックのモノトーン

バージョンを含むフォントを生成し、画像に「文字」としてオーバーレイすることができます。この

方法を使用すると、グラフィカルな透かしがあるように見えます。 
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以下のコマンドラインオプションが対応しています: 
 

Option Description 

 

--borderless 
画像のみのモードでEpiphan Capture Toolを起動します。Escキーで

画像のみのモードを終了します。 

 

--sn <serial number> 

使用するビデオグラバーを指定します（複数のビデオキャプチャワー

クステーションが接続されている場合）。 <serial number>は、目的

のビデオグラバーのシリアル番号です。 

--hs <value> 水平シフトの値を設定します。* 

--vs <value> 垂直シフトの値を設定します。* 

--phase <value> サンプリング位相の値を設定します。* 0 ～ 31の範囲内で設定できま

す。 

--pll PLL 調整を設定します。* 

--offset <value> オフセット (明るさ)を設定します。* 0 ～ 63の範囲内で設定できます。 

--gain <value> ゲイン (コントラスト)を設定します。* 0 ～ 63の範囲内で設定できま

す。 

 

--topmost 
アプリケーション画面が常に一番上の画面となります。 

--fullscreen Epiphan Capture Toolを全画面モードで起動します。 

"*" 詳細は デバイス設定をご参照ください。 

例 

1つ以上のコマンドラインオプションを含むデスクトップショートカットを作成できます。この例では、

Epiphan Capture Toolの実行可能なファイル名はv2ugui2.exeであり、C：\ Program Files \ Epiphan 

\ Frame Grabber Softwareにインストールされています。 

1. Windowsエクスプローラーを開き、次のパスに移動する：C:\Program Files\Epiphan\Frame Grabber 

Software 

2. v2ugui2.exeファイルを右クリックし、Create Shortcutを選択する。Windows は設定に応じてショート

カットファイル“Shortcut to v2ugui2.exe.lnk”を作成します。“.lnk” が表示されないこともあります。 

3. 必要に応じて、このファイル名を変更し、別の場所にコピーする。ファイル拡張子は変更しないでく

ださい。 
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4. ショートカットファイルを右クリックし、プロパティを選択する 

5. Target欄を編集し、終了引用符の後にコマンドラインオプションを追加する 

 

 
 

 

6. OKでショートカットに変更を保存する 

7. ショートカットをダブルクリックし、指定したコマンドラインオプションでビデオキャプチャアプ

リケーションを起動する 

たとえば、-topmost コマンドラインオプションを追加するには、ターゲット行を次のように変更しま

す。C:\Program Files\Epiphan\Frame Grabber Software\v2ugui2.exe" –topmost 

または、--topmost、--borderless を追加し、水平シフトを-67 に、垂直シフトを10 に設定するに

は："C:\Program Files\Epiphan\Frame Grabber Software\v2ugui2.exe" –topmost --borderless --

hs -67 --vs 10 
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付録 
 

 

⚫ ドライバとソフトウェアのアップグレード 

⚫ 制限と既知の問題 

⚫ Software license 
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ドライバとソフトウェアのアップグレード 

ドライバとEpiphan Capture Toolの最新バージョンはひとつのパッケージにまとめられており、Epiphan Video  

Web サイト（または弊社 HP：ダウンロードサイト）からダウンロードできます。 

通常、古いバージョンのアンインストールせずに新しいEpiphan Capture Toolのダウンロード、インスト

ールができます。ドライバのアップデートと最新のEpiphan Capture Toolのインストールについてはイン

ストールクイックスタート をご参照ください。 

DVI2PCIe Duoを使用する各キャプチャワークステーションのドライバとEpiphan Capture Tool

を必ず更新してください。デバイスを接続するたびに、デバイスはキャプチャワークステーシ

ョンからファームウェアをリロードします。 

https://www.argocorp.com/grabber/eizou/Epiphan/Epiphan_software.html#cap
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制限と既知の問題 

ここでは現在リリースされているバージョンの機能に影響を与える既知の問題と制限について記載して

おり、それらの回避策を紹介しています。 

⚫ DVI2PCIe Duoの3.5 mm音声ポートは、コンピュータのデバイスマネージャーでライン入力またはマ

イク入力として表示されます。 

回避策 :再起動後、コントロールパネルで変更を行う前にデバイスを使用しているアプリケーシ

ョンをすべて停止してください。すべてのアプリケーションが同じ入力デバイスを使用している

ことを確認してください。 

⚫ キャプチャワークステーションで、複数のアプリケーションで同時に映像信号を開くと、信号のパフ

ォーマンスに影響します。ライブストリーミングや録画中にパフォーマンスを下げないためには、映

像信号にアクセスする不要なアプリケーションをすべて閉じることをお勧めします。たとえば、ライ

ブストリーミングや録画にEpiphan Capture Toolを使用していない場合は、ビデオグラバーの設定が

済めばEpiphan Capture Toolを閉じます。 

⚫ Epiphan Capture Toolは、実際のVGA入力信号が1400x1050@60fpsであっても、アプリケーション画

面上では1680x1050と表示します。入力信号は影響を受けず、表示を無視するか、1400x1050@60fps

のカスタムビデオモードを追加することができます。 
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Software license 
ATTENTION: THE SOFTWARE AND DOCUMENTATION PROVIDED UNDER THIS AGREEMENT ARE BEING LICENSED 

TO YOU BY EPIPHAN SYSTEMS INC. ("LICENSOR") AND ARE NOT BEING SOLD. THIS AGREEMENT CONTAINS 

LIMITATIONS ON REPRESENTATIONS, WARRANTIES, CONDITIONS, REMEDIES, AND LIABILITIES THAT ARE 

APPLICABLE TO THE SOFTWARE AND DOCUMENTATION. 

Epiphan Systems Inc. 

Software License 

IMPORTANT: BEFORE DOWNLOADING, INSTALLING, OR USING THE SOFTWARE AND DOCUMENTATION, 

PLEASE CAREFULLY READ THIS AGREEMENT WHICH CONTAINS THE TERMS AND CONDITIONS UNDER WHICH 

YOU ARE ACQUIRING A LICENSE TO USE THE SOFTWARE AND DOCUMENTATION. IF YOU DO NOT ACCEPT THE 

TERMS AND CONDITIONS OF THIS AGREEMENT PLEASE DO NOT DOWNLOAD, INSTALL, OR USE THE SOFTWARE 

AND DOCUMENTATION AND PROMPTLY RETURN OR DESTROY THE SOFTWARE AND DOCUMENTATION. IF YOU 

DOWNLOAD, INSTALL, OR USE THE SOFTWARE AND/OR DOCUMENTATION, YOU WILL HAVE ACCEPTED AND 

AGREED TO THESE TERMS AND CONDITIONS. THE SOFTWARE, HARDWARE AND DOCUMENTATION ARE ALSO 

PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER 

INTELLECTUAL PROPERTY LAWS. IF YOU ARE AN AGENT OR EMPLOYEE OF AN ENTITY, YOU REPRESENT AND 

WARRANT THAT (I) THE INDIVIDUAL ACCEPTING THIS AGREEMENT IS DULY AUTHORIZED TO ACCEPT THIS 

AGREEMENT ON SUCH ENTITY'S BEHALF AND TO BIND SUCH ENTITY, AND (II) SUCH ENTITY HAS FULL POWER, 

CORPORATE OR OTHERWISE, TO ENTER INTO THIS AGREEMENT AND PERFORM ITS OBLIGATIONS UNDER THIS 

AGREEMENT. 

1. Definitions: In this Agreement: 

"Agreement" means this Epiphan Systems Inc. Software License; 

"API" means an application programming interface; 

"Documentation" means the technical publications delivered to You with the Software relating to the installation 
and operation of the Software and/or Hardware, such as reference, user, installation and technical guides and release 
notes; 

"Epiphan" means Epiphan Systems Inc; 

"Epiphan Hardware Product" means an Epiphan hardware product (including enclosure and mechanical parts, 
circuitry and electrical and electronic components contained therein) purchased by You, which is intended to be used 
in conjunction with the licensed Software and Documentation; 

"License Key" means a series of computer-generated characters used for the purpose of controlling the operation of 
Epiphan Hardware Products and/or related Software; 

"Software" means the Licensor binary and/or bytecode software and/or firmware programs that are (i) specified in 
Your Order or that are included with or in the Epiphan Hardware Products specified in Your Order, (ii) are made 
available to You for download after acceptance of this Agreement, (iii) are packaged with this Agreement, (iv) pre- 
installed on Epiphan Hardware Products, (v) embed this Agreement in their installer(s) and which are installed after 
acceptance of this Agreement, or (vi) embed this Agreement in their product documentation. Software also includes 
the related Documentation; 
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"You" or "Your" means the individual acquiring the Software license or any entity on whose behalf such individual is 
acting. In the case of an entity, "You" includes any entity that by majority voting interest controls, is controlled by, or is 
under common control with You; and 

"Your Order" means (i) the web forms provided by Epiphan or its applicable reseller or distributor for ordering 
Epiphan Hardware Products and related Software licenses, or (ii) written documents executed by Epiphan, or one of 
its resellers or distributors, and You in respect to Your purchases of Epiphan Hardware Products and/or related 
Software licenses. 

2. Grant of Software License: Subject to the terms and conditions of this Agreement, including payment of any 
applicable fees specified in Your Order, Licensor grants You a non-exclusive, non-transferable, non-sublicensable, 
internal license to use the number of copies of the Software specified in Your Order and to use the Software functions 
specified in Your Order solely for operation on the Epiphan Hardware Products for which such Software has been 
designed as specified in the Documentation for such Software. If the number of copies of Software is not specified in 
Your Order, then the number of copies shall be a reasonable number of copies. You acknowledge and agree that the 
ability to use certain Software functions is controlled by a Licensing Key and that You will not be able to use such 
functions unless You have paid the applicable fees charged by Epiphan for the right to use such functions and to 
receive a Licensing Key to enable such functions. For functions that are controlled by a Licensing String You shall only 
use that Licensing String with the copy of the Software for which it was issued and You shall not use that copy of the 
Licensing String with any other copies of the Software that You may have or make. All copies of the Software made by 
You shall include all trademarks, copyright notices, restricted rights legends, proprietary markings and the like exactly 
as they appear on the copy of the Software originally provided to You. No other rights in the Software or 
Documentation are granted to You. 

3. Open Source Software: Binary, bytecode and source code versions of certain open source software packages may 
be embedded in or distributed with the Software ("Open Source Software"). If a separate license agreement for an 
item of open source software is: delivered to You with the Software; included in the download package for the 
Software; referenced in any material (including the Documentation) that is included in the download or distribution 
package for the Software; or listed at www.epiphan.com/opensource, then such open source software shall be Open 
Source Software and such separate license agreement shall govern Your use of that item or version of such open 
source software. The Open Source Software may include free software (i.e. software licensed under the GNU Lesser 
General Public License or other free software licenses) for which the applicable free software license may also require 
that the source code for such free software be made available to those receiving only executable versions of such free 
software. If the source code for any free software distributed with the Software is not provided with the Software, 
then upon request, within a three (3) year period from the original receipt of the binary or bytecode version of such 
Open Source Software from Licensor, for a fee that shall not exceed Licensor's costs associated with the shipping of 
the source code for such free software, Licensor will provide a copy of the source code for such free software to You. 

4. Restrictions: The terms set forth in this Section 4 are additional conditions to the licenses granted in Section 2. 
Your right to use the Software is conditioned upon Your timely payment of the full amount of fees due for: (i) the 
Epiphan Hardware Product(s) on which You want to use the Software; (ii) all support agreements You have entered 
into with Licensor or any of its distributors and/or resellers; (iii) licensed Software and Documentation. 

You shall not reverse engineer, disassemble, reverse translate, decompile or in any other manner decode any 
Epiphan Hardware Product or Software except to the extent the Software is distributed with any Open Source 
Software that prohibits the imposition of such a restriction or to the extent the foregoing restriction is expressly 
prohibited by applicable law notwithstanding a contractual obligation to the contrary. You acknowledge and agree 
that no rights in respect to the source code of the Software are granted to You. You acknowledge and agree that the 

http://www.epiphan.com/opensource
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rights in respect to use of the Software and Documentation are granted only for use in conjunction with Epiphan 
Hardware Products. You shall not distribute, lease, rent, grant a security interest in, assign, or otherwise transfer the 
Software except as expressly provided in this Agreement. You shall not modify or create any derivatives works of the 
Software or merge all or any part of the Software with another program. Notwithstanding the foregoing, You may call 
public APIs made available by Epiphan in the Software from applications developed by or on Your behalf provided 
that such applications do not embed any of the Software other than the minimum linkage materials required to call 
separately running instances of the Software. You shall not use the Software or make the Software available to any 
third parties as part of any service bureau, time sharing service, application service provider offering, software-as-a- 
service offering or any other managed service offering. You shall not disclose any performance, benchmarking, or 
feature-related information about the Software. You further agree not to disclose, transfer or otherwise provide to 
any third party any portion of the Software, except as expressly permitted herein. 

Some Epiphan Hardware Products and Software embed third-party APIs that integrate with third-party party services 
(“Third-Party Services”) to allow users of such Epiphan Hardware Products and Software to interact with such Third- 
Party Services for various capabilities offered by such Third-Party Services, such as, and without limitation, 
authentication, uploading and downloading of video content and other features made available by such Third-Party 
Services. If You access or use any Third-Party Service and/or related APIs using an Epiphan Hardware Product and/or 
the Software then You shall comply with all of the terms and conditions for such Third-Party Service and/or related 
APIs. 

5. Disclaimer of Warranties: EXCEPT FOR ANY WARRANTIES THAT MAY BE PROVIDED IN ANY COMMERCIAL 

AGREEMENT EXECUTED BETWEEN YOU AND LICENSOR (OR BETWEEN YOU AND ONE OF LICENSOR’S RESELLERS 

OR DISTRIBUTORS), THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE AND/OR DOCUMENTATION ARE 

PROVIDED “ AS IS”, WITHOUT ANY REPRESENTATIONS, CONDITIONS, AND/OR WARRANTIES OF ANY KIND. 

WITHOUT LIMITATION, LICENSOR AND ITS AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, 

SUBCONTRACTORS, RESELLERS AND DISTRIBUTORS DISCLAIM ANY AND ALL IMPLIED REPRESENTATIONS, 

CONDITIONS AND/OR WARRANTIES OF MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, 

DURABILITY, COMPATIBILITY, TITLE, SATISFACTORY QUALITY AND/OR FITNESS FOR A PARTICULAR PURPOSE 

WHETHER ARISING BY STATUTE, COURSE OF DEALING, USAGE OF TRADE OR OTHERWISE. EXCEPT AS 

OTHERWISE EXPRESSLY PROVIDED IN ANY COMMERCIAL AGREEMENT EXECUTED BETWEEN YOU AND 

LICENSOR (OR BETWEEN YOU AND ONE OF LICENSOR’S RESELLERS OR DISTRIBUTORS), THE ENTIRE RISK OF 

THE USE OF THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE AND/OR DOCUMENTATION SHALL BE BORNE BY 

YOU. EXCEPT AS OTHERWISE EXPRESSLY PROVIDED IN ANY COMMERCIAL AGREEMENT EXECUTED BETWEEN 

YOU AND LICENSOR (OR BETWEEN YOU AND ONE OF LICENSOR’S RESELLERS OR DISTRIBUTORS), NEITHER 

LICENSOR NOR ANY OF ITS AFFILIATES NOR ANY OF ITS OR THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, 

RESELLERS AND/OR DISTRIBUTORS MAKE ANY REPRESENTATIONS OR PROVIDE ANY CONDITIONS AND/OR 

WARRANTIES ABOUT THE SUITABILITY OF THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE, SERVICES AND/OR 

DOCUMENTATION. NEITHER LICENSOR NOR ANY OF ITS AFFILIATES NOR ANY ITS OR THEIR LICENSORS, 

SUPPLIERS, SUBCONTRACTORS, RESELLERS AND/OR DISTRIBUTORS MAKE ANY REPRESENTATIONS OR PROVIDE 

ANY CONDITIONS AND/OR WARRANTIES WHATSOEVER ABOUT ANY INFORMATION AND/OR DATA THAT MAY 

BE PROCESSED BY OR MADE AVAILABLE USING ANY EPIPHAN HARDWARE PRODUCT AND/OR SOFTWARE OR 

ABOUT ANY THIRD-PARTY SERVICE THAT MAY BE ACCESSIBLE USING ANY EPIPHAN HARDWARE PRODUCT 

AND/OR SOFTWARE. 

6. LIMITATION OF LIABILITY: NEITHER LICENSOR NOR ANY OF ITS AFFILIATES NOR ANY OF ITS OR THEIR 

LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS AND/OR DISTRIBUTORS SHALL HAVE ANY LIABILITY TO 

YOU OR ANY OTHER PERSON OR ENTITY FOR ANY DAMAGES ARISING FROM THIS AGREEMENT, RELATING TO 
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THE HARDWARE, SOFTWARE OR DOCUMENTATION, OR RELATING TO ANY SERVICES PROVIDED TO YOU BY 

LICENSOR (INCLUDING ITS AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, 

RESELLERS AND/OR DISTRIBUTORS) IN RELATION TO THE EPIPHAN HARDWARE PRODUCTS, SERVICES, 

SOFTWARE AND/OR DOCUMENTATION FOR ANY INDIRECT, RELIANCE, INCIDENTAL, SPECIAL, PUNITIVE, 

EXEMPLARY OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, 

LOSS OF OR DAMAGE TO DATA, BUSINESS INTERRUPTION, LOSS OF DATA, REPLACEMENT OR RECOVERY 

COSTS, OR OTHER COMMERCIAL OR ECONOMIC LOSS, WHETHER ARISING FROM CONTRACT, EQUITY, TORT 

(INCLUDING NEGLIGENCE OR STRICT LIABILITY) OR ANY OTHER THEORY OF LIABILITY, EVEN IF LICENSOR 

(INCLUDING ITS AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS 

AND/OR DISTRIBUTORS) HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE 

FORESEEABLE. THE LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR 

DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR TERM OR FUNDAMENTAL BREACH. SOME 

JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 

INCIDENTAL DAMAGES, SO THESE LIMITATIONS MAY NOT APPLY TO YOU. IN NO EVENT SHALL THE TOTAL 

CUMULATIVE LIABILITY OF LICENSOR (INCLUDING ITS AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, 

SUBCONTRACTORS, RESELLERS AND DISTRIBUTORS) TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY 

DAMAGES ARISING FROM THIS AGREEMENT, RELATING TO THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE, 

DOCUMENTATION AND/OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICENSOR (INCLUDING ITS 

AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS AND DISTRIBUTORS) IN 

RELATION TO THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE AND/OR DOCUMENTATION, EXCEED THE 

LICENSE FEES PAID BY YOU FOR THE SOFTWARE. 

NOTWITHSTANDING ANY OTHER PROVISION IN THIS AGREEMENT, NEITHER LICENSOR NOR ANY OF ITS 

AFFILIATES OR ITS OR THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS AND/OR DISTRIBUTORS 

SHALL HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY WHATSOEVER IN RESPECT TO ANY 

DIRECT, INDIRECT, RELIANCE, INCIDENTAL, SPECIAL, PUNITIVE, EXEMPLARY OR CONSEQUENTIAL DAMAGES, 

INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOSS OF OR DAMAGE TO DATA, BUSINESS 

INTERRUPTION, LOSS OF DATA, REPLACEMENT OR RECOVERY COSTS, OR OTHER COMMERCIAL OR ECONOMIC 

LOSS, ARISING FROM OR RELATING TO ANY INFORMATION AND/OR DATA THAT MAY BE PROCESSED BY OR 

MADE AVAILABLE USING ANY EPIPHAN HARDWARE PRODUCT AND/OR SOFTWARE OR ARISING FROM OR 

RELATING TO ANY THIRD-PARTY SERVICE THAT MAY BE ACCESSIBLE USING ANY EPIPHAN HARDWARE 

PRODUCT AND/OR SOFTWARE. 

THE DISCLAIMER OF REPRESENTATIONS, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY 

CONSTITUTE AN ESSENTIAL PART OF THIS AGREEMENT. YOU ACKNOWLEDGE THAT BUT FOR THE DISCLAIMER 

OF REPRESENTATIONS, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY, NEITHER LICENSOR NOR 

ANY OF ITS AFFILIATES OR ITS OR THEIR LICENSORS, SUPPLIERS, RESELLERS OR DISTRIBUTORS WOULD 

GRANT THE RIGHTS GRANTED IN THIS AGREEMENT. 

7. Term and Termination: This Agreement shall continue for as long as You use the Software, however, it may be 
terminated sooner as provided in this Section 7. You may terminate this Agreement by destroying all copies of the 
Software and Documentation under Your control and providing certification of such destruction to Licensor or by 
returning the Software to Licensor. Licensor may terminate this Agreement immediately by providing You with written 
notice if: (a) You are in material breach of any provision of this Agreement, which breach, if capable of being cured, is 
not cured within thirty (30) days after Licensor gives You written notice thereof; or (b) You have committed a non- 
curable material breach of this Agreement. Upon termination You shall destroy all copies of the Software and 
Documentation. In addition to this Section, the Sections entitled Definitions, Disclaimer of Warranties, Limitation of 



DVI2PCIe Duo User Guide Software license 

77 

 

 

 

Liability, Title, Indemnities, High-Risk Activities, Intellectual Property, and General shall continue in force even after 
any termination of this Agreement. No termination of this Agreement will entitle You to a refund of any amounts paid 
by You to Licensor or any reseller or distributor or affect any obligations You may have to pay any outstanding 
amounts owing to Licensor or any reseller or distributor. Upon any termination of this Agreement, Your license to the 
Software and Documentation will terminate and You shall destroy all copies of the Software and Documentation 
under Your control and certify such destruction to Licensor. 

8. Support and Updates: This Agreement does not grant You the right to any updates or enhancements of the 
Software or the right to receive any technical support for the Software. Such updates and other technical support 
services, if available, may be purchased separately from Licensor or one of Licensor’s resellers or distributors. Use of 
any updates or enhancements to the Software provided pursuant to any technical support You may procure from 
Licensor or one of Licensor’s resellers or distributors shall be governed by the terms and conditions of this 
Agreement. Licensor reserves the right at any time not to release or to discontinue the release of any Software and to 
alter prices, features, specifications, capabilities, functions, licensing terms, release dates, general availability or other 
characteristics of the Software. 

9. Title: All right, title, and interest (including all intellectual property rights) in, to, and under the Software (including 
all copies thereof) shall remain with Licensor and its licensors. 

10. Indemnities: You shall indemnify, defend and hold Licensor, its affiliates, its and their licensors, suppliers, 
subcontractors, resellers and/or distributors and all of the directors, officers, employees of all of the foregoing 
(collectively the “Indemnified Parties”) harmless from and against any damages, losses, liabilities, expenses, costs, 
claims, demands, actions, suits and/or proceedings incurred by the Indemnified Parties as a result of (i) Your use of 
the Epiphan Hardware Products, Software and/or Documentation, (ii) any use of the Epiphan Hardware Products, 
Software and/or Documentation on Your behalf, (iii) the use of the Epiphan Hardware Products, Software and/or 
Documentation by anyone to whom You give the Epiphan Hardware Products, Software and/or Documentation, 
and/or (iv) the use of the Epiphan Hardware Products, Software and/or Documentation on behalf of anyone to whom 
You give the Epiphan Hardware Products, Software and/or Documentation, including, without limitation, in all of the 
foregoing cases, any damages, losses, liabilities, expenses, costs, claims, demands, actions, suits and/or proceedings 
arising from or relating to any information and/or data that may be processed by or made available using any 
Epiphan Hardware Product and/or Software or arising from or relating to any Third-Party Service that may be 
accessible using any Epiphan Hardware Product and/or Software (collectively, each matter falling within any of the 
foregoing, a “Claim”), including, without limitation, indemnifying, defending and holding the Indemnified Parties 
harmless from and against any settlements agreed by You in connection with any Claims and/or any damages, costs 
or other amounts (including reasonable attorneys' fees) awarded to a third party against any of the Indemnified 
Parties by a court or tribunal of competent jurisdiction in respect to any Claim. If You do not timely defend against or 
resist a Claim after notice from Licensor, Licensor shall be entitled to investigate, defend, compromise, settle, or 
otherwise dispose of the Claim, and incur costs in connection therewith, at Your expense, in such manner as Licensor 
deems in its best interests until a reasonable time after You comply with its obligations under this Section 10. You 
shall not enter into a settlement of any Claim without the Licensor’s written consent unless such settlement is solely 
for monetary payment by You and contains an express, complete, unconditional release of all of the Indemnified 
Parties and which does not impose any obligations or restrictions on any of the Indemnified Parties. 

11. High-Risk Activities: The Software and Epiphan Hardware Products are not fault-tolerant and are not designed, 
manufactured or intended for use in or in conjunction with on-line control equipment in hazardous environments 
requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation systems, air traffic 
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control, or direct life support machines. Licensor, its licensors, suppliers, subcontractors, resellers and distributors 
specifically disclaim any express or implied representations, warranties and/or conditions for such uses. 

12. U.S. Government End-Users: The Software and Documentation are each a "commercial item" as that term is 
defined at FAR 2.101, consisting of "commercial computer software" and "commercial computer software 
documentation" as such terms are defined in FAR 12.212, and are provided to the U.S. Government only as 
commercial end items. Government end users acquire the rights set out in this Agreement for the Software, Epiphan 
Hardware Products and Documentation consistent with: (i) for acquisition by or on behalf of civilian agencies, the 
terms set forth in FAR12.212; or (ii) for acquisition by or on behalf of units of the Department of Defense, the terms 
set forth in DFARS 227.7202. Use of the Epiphan Hardware Products, Software and Documentation is further 
restricted by the terms and conditions of this Agreement and the applicable commercial purchase agreement for the 
Epiphan Hardware Products. For the purposes of any applicable government use, the Epiphan Hardware Products, 
Software and Documentation were developed exclusively at private expense, and are trade secrets of Epiphan 
Systems Inc. for the purpose of any Freedom of Information legislation or any other disclosure statute, regulation or 
provision. 

13. Export Restrictions: The Epiphan Hardware Products, Software, Documentation and related information are 
subject to export and import restrictions. By downloading, installing, or using the Software, Epiphan Hardware 
Products, Documentation and/or related information, You are representing and warranting that You are not located 
in, are not under the control of, and are not a national or resident of any country to which the export of the Epiphan 
Hardware Products, Software, Documentation and/or related information would be prohibited by the laws and/or 
regulations of Canada or the United States. You are also representing and warranting that You are not an individual to 
whom the export of the Epiphan Hardware Products, Software, Documentation or related information would be 
prohibited by the laws and/or regulations of Canada or the United States. You shall comply with the export laws and 
regulations of Canada and the United States that are applicable to the Epiphan Hardware Products, Software, 
Documentation and related information and You shall also comply with any local laws and/or regulations in Your 
jurisdiction that may impact Your right to export, import, or use the Epiphan Hardware Products, Software, 
Documentation or related information, and You represent and warrant that You have complied with any such 
applicable laws and/or regulations. The Epiphan Hardware Products, Software, Documentation and related 
information shall not be used for any purposes prohibited by export laws and/or regulations, including, without 
limitation, nuclear, chemical, or biological weapons proliferation. You shall be responsible for procuring all required 
permissions for any subsequent export, import, or use of the Epiphan Hardware Products, Software, Documentation 
or related information. 

14. Intellectual Property: Epiphan, Epiphan Systems and Epiphan Video are tradenames, trademarks or registered 
trademarks of Epiphan Systems Inc. in certain countries. All Licensor product names and logos are trademarks or 
registered trademarks of Epiphan Systems Inc. in certain countries. All other company and product names and logos 
are trademarks or registered trademarks of their respective owners in certain countries. You shall not disclose, 
transfer or otherwise provide to any third party any portion of the Software, except as expressly permitted in this 
Agreement. 

15. General: This Agreement is the entire agreement between You and Licensor in respect to the Software, 
superseding any other agreements or discussions, oral or written. The terms and conditions of this Agreement shall 
prevail over any pre-printed terms on any quotes, orders, purchase orders, or purchase order acknowledgements, 
and shall prevail over any other communications between the parties in relation to the Software. You may not assign 
this Agreement whether voluntarily, by operation of law, or otherwise without Licensor's prior written consent. 
Licensor may assign this Agreement at any time without notice. The failure of a party to claim a breach of any term of 
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this Agreement shall not constitute a waiver of such breach or the right of such party to enforce any subsequent 
breach of such term. If any provision of this Agreement is held to be unenforceable or illegal, such decision shall not 
affect the validity or enforceability of such provisions under other circumstances or the remaining provisions of this 
Agreement and such remaining provisions shall be reformed only to the extent necessary to make them enforceable 
under such circumstances. This Agreement shall be governed by the laws of the Province of Ontario and the laws of 
Canada applicable therein. No choice or conflict of laws rules of any jurisdiction shall apply to this Agreement. You 
shall only be entitled to bring any action or proceeding arising out of or relating to this Agreement, the Epiphan 
Hardware Products, Software, Documentation or any services provided in respect to the Epiphan Hardware Products, 
Software and/or Documentation in a court in Ottawa, Ontario, Canada, and You consent to the jurisdiction of such 
courts for any such action or proceeding. You waive all rights that You may have or that may hereafter arise to contest 
the jurisdiction of such courts for any action or proceeding brought by You. You hereby waive any right You may have 
to request a jury trial with respect to any action brought by You in connection with this Agreement, the Epiphan 
Hardware Products or Software or any services provided in respect to the Epiphan Hardware Products or Software. 
The application of the United Nations Convention on Contracts for the International Sale of Goods to this Agreement 
is expressly excluded. 

 

Environmental Information 

The equipment that you bought has required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment. In order to avoid the dissemination of 
those substances in our environment and to diminish the pressure on the natural resources, we encourage you to 
use the appropriate take-back systems. Those systems will reuse or recycle most of the materials of your end life 
equipment in a sound way. The crossed-out wheeled bin symbol invites you to use those systems. If you need more 
information about collection, reuse and recycling systems, please contact your local or regional waste administration. 
You can also contact us for more information on the environmental performance of our products. 

Important Safety Warnings 

WARNING: This product has no user-serviceable parts and the battery used in this device is not replaceable. Do not 
attempt to disassemble. Return the device for service. 

CAUTION, RISK OF ELECTRIC SHOCK: This device may have multiple AC power cords installed. All power sources shall 
be disconnected before servicing to avoid shock hazard. 

ATTENTION: Cet appareil ne contient aucun composant pouvant être entretenu ou réparé par l'utilisateur. En cas de 
panne, retourner l'appareil pour réparation. 

ATTENTION, RISQUE DE CHOC ÉLECTRIQUE: Cet appareil peut être équipé de multiples cordons d'alimentation en 
courant alternatif. Pour placer cet appareil hors tension, débrancher tous les cordons d'alimentation sans exception. 

FCC Compliance Statement 

47 CFR Section 2.1077 Compliance Information 

Unique identifier: DVI2PCIe DuoPearl-2 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

1. This device may not cause harmful interference 
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2. This device must accept any interference received, including interference that may cause undesired operation. 

Responsible party (US contact): 

Epiphan Video 
459 Hamilton Avenue, Suite 301 
Palo Alto, CA 
94301, USA 

www.Epiphan.com 

FCC CAUTION 

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s 
authority to operate the equipment. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures: 

– Reorient or relocate the receiving antenna. 

– Increase the separation between the equipment and receiver. 

– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

– Consult the dealer or an experienced radio/TV technician for help. 

Innovation, Science and Economic Development Canada: 

This device complies with ICES-003 of the ISED rules. Operation is subject to the following two conditions: 

(1) This device may not cause harmful interference, and 

(2) this device must accept any interference received, including interference that may cause undesired operation. 

Cet appareil est conforme à la norme ISED NBM-003 pour les appareils radio agréés. Son fonctionnement est sujet 
aux deux conditions suivantes: 

(1) le dispositif ne doit pas produire de brouillage préjudiciable, et 

(2) ce dispositif doit accepter tout brouillage reçu, y compris un brouillage susceptible de provoquer un 
fonctionnement indésirable. 

CE Compliance Statement 

Marking by the symbol   indicates compliance of this device with the applicable directives of the European 
Community and meets or exceeds the following technical standards: 

Directive 2014/30/EU - Electromagnetic Compatibility 

http://www.epiphan.com/
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Directive 2011/65/EU - RoHS, restriction of the use of certain hazardous substances in electrical and electronic 
equipment 

 

 

 

Other Jurisdictional Issues 

Epiphan makes no representation that its products or information in this document or its web site is appropriate or 
available for use in your jurisdiction. Those who choose to access the Epiphan web site or use Epiphan products do so 
on their own initiative and are responsible for compliance with local laws, if and to the extent local laws are applicable 

Submissions to Epiphan and Affiliated Servers 

Any information, including but not limited to remarks, suggestions, ideas, graphics, or other submissions, 
communicated to Epiphan through their Epiphan web site is the exclusive property of Epiphan. Epiphan is entitled to 
use any information submitted for any purpose, without restriction (except as stated in Epiphan's Privacy Statement) 
or compensation to the person sending the submission. The user acknowledges the originality of any submission 
communicated to Epiphan and accepts responsibility for its accuracy, appropriateness, and legality. 

Third Parties and Links to Third-Party Web Sites 

Mention of non-Epiphan Systems Inc. products or services on their website, or this document site is for informational 
purposes and does not constitute an endorsement or recommendation. 

This document may contain links to non-Epiphan web sites. These links are provided to you as a convenience, and 
Epiphan is not responsible for the content of any linked web site. Any outside web site accessed from the Epiphan 
web site is independent from Epiphan, and Epiphan has no control over the content of that web site. In addition, a 
link to any non-Epiphan web site does not imply that Epiphan endorses or accepts any responsibility for the content 
or use of such a web site. 

In no event shall any reference to any third party or third party product or service be construed as an approval or 
endorsement by Epiphan of that third party or of any product or service provided by a third party. 

Miscellaneous 

It is the user's responsibility to ascertain whether any information downloaded from the Epiphan web site or other 
websites is free of viruses, worms, trojan horses, or other items of a potentially destructive nature. 

Enforcement of Terms and Conditions 

These Terms and Conditions for use of this document and the associated Epiphan Product are governed and 
interpreted pursuant to the laws of the province of Ontario, Canada, notwithstanding any principles of conflicts of 
law. 

All disputes arising out of or relating to these Terms and Conditions shall be finally resolved by arbitration conducted 
in the English language in Ottawa, Ontario, Canada under the commercial arbitration rules of the Canada. The parties 
shall appoint as sole arbitrator a retired judge who presided in the province of Ontario. The parties shall bear equally 
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the cost of the arbitration (except that the prevailing party shall be entitled to an award of reasonable attorneys' fees 
incurred in connection with the arbitration in such an amount as may be determined by the arbitrator). All decisions 
of the arbitrator shall be final and binding on both parties and enforceable in any court of competent jurisdiction. 
Notwithstanding this, application may be made to any court for a judicial acceptance of the award or order of 
enforcement. Notwithstanding the foregoing, Epiphan shall be entitled to seek injunctive relief, security, or other 
equitable remedies from any court of competent jurisdiction. 

If any part of these terms is unlawful, void, or unenforceable, that part will be deemed severable and will not affect 
the validity and enforceability of the remaining provisions. Epiphan may, at its sole discretion and without notice, 
revise these terms at any time by updating this posting. 

Copyright © 2018 Epiphan Systems Inc. 

All Rights Reserved. 

© and ™ 2018, Epiphan Systems, Inc 


